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Chapter 1. Introduction

Tivoli IT Director is a highly-integrated systems management application.
Version 2.11 of Tivoli IT Director extends the management ability to the
AS/400 platform and provides powerful solutions for small-and medium-sized
businesses. This redbook enhances your Tivoli small-to-medium business
solution design skills for AS/400 systems management and provides
examples of implementation and solutions.

1.1 Concept and architecture

Efficient information technology (IT) management is a challenge. As the IT
manager for your small-to-medium sized business, you face daily challenges
and inefficiencies trying to control all your IT resources.

The right systems management software is the key to total control over your
IT environment. You might not realize the amount of money that the lack of
comprehensive systems management is costing your company. Moreover,
you may not be realizing the true value of information technology to your
business without control and efficient management.

IT management means more than automating repetitive tasks. The ability to
gain control of your applications, systems, and network allows you to
proactively plan for new technology and expanding business requirements.
You can make IT a strategic resource for your business. With effective IT
management, you can plan for new technology and future corporate growth,
remain current on emerging products and computing innovations, and
maintain a strategic view of your IT resources.

Tivoli IT Director is the first systems management product designed for the
unique needs of small-to-medium businesses with Windows NT or AS/400.
Tivoli IT Director puts the IT manager in control of the IT environment, giving
him or her accountability and agility. Unlike the other available tools that
narrowly focused on other problems, Tivoli IT Director is designed from the
ground up for the small business IT manager, providing the optimum balance
between breadth and depth of management functions and simplicity. Tivoli IT
Director is easy to use and offers many benefits, including:

• Rapid installation

• Intuitive centralized management console

• Comprehensive, integrated, and automated management functions
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• Snap-in integration with leading business applications and management
products

• Rapid return on investment

Tivoli IT Director allows you to view and manage all of your IT resources from
an active, Internet-enabled management console. Figure 1 shows the IT
Director Management Console.

Figure 1. Tivoli IT Director Management Console

The intuitive, integrated management console reduces the need for extensive
training and immediately improves administrator productivity. Tivoli IT Director
lets you and your administrators manage hundreds of systems centrally and
consistently—saving time and money.

Tivoli IT Director reduces not only operator and administrator workload but
also setup (installation and configuration) difficulties. Tivoli IT Director
includes all management functions that are needed to manage a
small-to-medium business. The following shows the management functions
that Tivoli IT Director for AS/400 provides:

• Inventory management
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• Resource monitoring

• Event management

• Software distribution

• File transfer

• SNMP management

• Process management

• Task scheduler

• Internet services

These management functions are highly integrated and enable you to perform
seamless management operations. You do not have to install and configure
each management function shown above. In other words, the Tivoli IT
Director CD-ROM contains these management function modules in a single
disk. It simplifies the installation and configuration process.

For example, if a company does not have a DP department but an
administrator has to manage all IT resources, Tivoli IT Director can be a
powerful solution in this case. This may happen in small-to-medium business
environments.

If you consider the total costs of your IT resource management including
setup, operator education, and ease-of-use, Tivoli IT Director can be the best
answer.

Tivoli IT Director provides a smart management solution for small-to-medium
sized businesses.

1.2 Tivoli IT Director and Tivoli Enterprise

Tivoli provides a variety of systems management tools for small-to-large sized
businesses. In today’s distributed systems environments, customers have a
lot of requirements and management environments are complicated. To
perform efficient systems management, you need to select and implement
proper management tools.

Tivoli IT Director provides additional management abilities for Windows
management agents. Please refer to the Tivoli IT Director User’s Guide,
which is shipped with the product, for more information.

Note
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Tivoli has two IT management solutions that allow a variety of customers to
manage their IT resources effectively. These IT management solutions are:

• Tivoli IT Director

• Tivoli Enterprise

Figure 2 shows the position of each IT management solution.

Figure 2. Tivoli IT Director and Enterprise

As you can see, Tivoli IT Director covers small-to-medium environments and
Tivoli Enterprise covers medium-to-large environments. Tivoli IT Director will
be a powerful IT management solution for:

• Small-to-medium businesses

• Customers without a DP department or sufficient IT administrators

• Managing IT resources at a low cost

• Implementing an IT management system quickly

In this redbook, we primarily introduce detailed information about how to plan
for, install, control, configure, and use Tivoli IT Director for AS/400.

Size

Complexity
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Systems

IBM NetfinityIBM Netfinity

DirectorDirector
PC Hardware
Management

TivoliTivoli

EnterpriseEnterprise

Comprehensive Management of
Enterprise IT Infrastructure,

Applications, and Service Levels
TivoliTivoli

IT DirectorIT Director

Management Solution for
Small & Medium Businesses
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1.2.1 About Tivoli Enterprise
Tivoli Enterprise is an IT management solution that allows organizations to
centrally manage their entire enterprise, including systems, applications,
hardware, and network devices. At the heart of Tivoli Enterprise is a
three-tiered architecture, which scales to manage IT environments with
thousands to hundreds of thousands of devices, and a powerful, intelligent
management agent that quickly detects changes within the environment and
brings new devices and software applications under Tivoli management.

We do not explain Tivoli Enterprise later in this redbook. However, if you
would like to know more about Tivoli Enterprise, please refer to the following
redbook:

• Managing AS/400 with Tivoli Enterprise, SG24-5517

This redbook provides detailed information about Tivoli Enterprise and
AS/400 systems management.

1.3 AS/400 and Tivoli IT Director

What is AS/400? It is the world’s most popular multi-user business computing
system, sold in more than 120 countries, enabled in 51 national languages,
and installed in 98 percent of Fortune magazine’s top 100 companies. The
success of AS/400 is mainly due to its low total cost of ownership and high
reliability and scalability.

The proper management of an AS/400 should result in a fast, efficient, and
reliable system. It should be secure and utilize auditing capabilities if
necessary. The Tivoli products for AS/400 introduce a new approach to
managing your AS/400s. They bring new functionality and integration to
enhance your existing support service.

As networks grow and computing needs become more complex and
demanding, the need for centralized management becomes more apparent. A
computing platform can no longer be seen as a stand-alone system if it is to
be efficiently and cost effectively utilized. Tivoli exploits the concept of central
management. It controls the basic and advanced tasks of computer system
management in a organization from one central console. Tivoli gives you “The
Power to Manage. Anything. Anywhere.”. Tivoli produces a product, Tivoli IT
Director, specifically designed to manage distributed computer systems. Now,
Tivoli has extended its array of supported platforms to incorporate the
AS/400.
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Tivoli IT Director now runs natively on AS/400 servers, providing you the
choice to use Windows NT or AS/400 as the primary management server
platform. The Tivoli IT Director Management Agent also runs on AS/400
systems as well as the Tivoli IT Director Management Server.

The Tivoli IT Director Management Agent product for AS/400 has a very small
storage footprint, so it will not take up large amounts of valuable data storage
space on your systems. It includes many advanced functions that can be
tailored to meet the needs of your AS/400 environment. The Tivoli IT Director
Management Console graphical user interface allows you to perform most
functions with a click or drag-and-drop of the mouse.

Now, your computing systems, such as AS/400, Windows, OS/2, and
NetWare, can be managed from a central source using a standard interface
and a common environment.

1.4 Version 2.11 of Tivoli IT Director

This section addresses the differences between Tivoli IT Director V2.11 and
V1.x. It also provides an overview of Tivoli IT Director V2.11.

Naturally, for this book, the most important feature is the addition of AS/400
into the list of supported platforms. Especially since it not only supports the
Agent, but also the IT Director Management Server. For the prerequisites for
the installation of the software on the AS/400 platform, refer to Chapter 3,
“Tivoli IT Director for AS/400: Planning” on page 11.

The database support has also been expanded, most importantly for AS/400,
to include IBM DB2 Universal Database Server Version 5.2 support.
Therefore, AS/400 is capable of running the IT Director database on its own
DB2 Server.

The rest of this redbook primarily introduces detailed information about
Version 2.11 of Tivoli IT Director for AS/400.
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Chapter 2. Product information

This chapter contains information about the Tivoli IT Director package and
features. Reference information and information about future features are
also provided.

2.1 Tivoli IT Director package

The Tivoli IT Director package comes with two CD-ROMs, a manual, and a
server license key.

CD-ROM2 contains all the necessary files to install the Tivoli IT Director
Management Agent, Management Console, and Management Server in an
AS/400 environment. CD1 contains the necessary files for other operating
systems. This redbook contains setup and management information only for
AS/400. For information about other operating systems, please refer to the
Tivoli IT Director User’s Guide or to other documents listed in 2.3, “Related
documents and information” on page 8.

The Tivoli IT Director User’s Guide contains a lot of pertinent information and
we often refer to it, so please keep it handy if performing an installation.

The server license key is needed during installation. It will also give you the
first 20 client licenses without which you cannot manage any systems.

2.2 Tivoli IT Director for AS/400 product

The Tivoli IT Director Management Server is a multi-purpose tool designed to
give you control over machines remotely, provide you with automation
options, and give you warning when something is wrong in your environment.

To fully function, the IT Director Management Server needs the IT Director
Management Agent software installed on the target machine. Also, some
functionality is limited to Windows and OS/2 systems only. Refer to Table 2 on
page 20 for a list of features supported under different operating systems.

2.2.1 Integrated Netfinity Server (INS)
If you are running INS in an AS/400 environment, it is good to remember that
it supports the Windows NT version of IT Director and not the AS/400 version.
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2.3 Related documents and information

In addition to your Tivoli IT Director User’s Guide, the most valuable source of
BM Redbooks. You can find the Redbooks home page at the following URL:

http://www.redbooks.ibm.com

The following are the URLs of the Tivoli IT Director Redbooks that we refer to:

• Tivoli IT Director Automation, SG24-5295

http://www.redbooks.ibm.com/abstracts/sg245295.html

• Integration Examples for Tivoli IT Director: A First Look, SG24-5207

http://www.redbooks.ibm.com/abstracts/sg245207.html

• The AS/400 NetServer Advantage, SG24-5196

http://www.redbooks.ibm.com/pubs/pdfs/redbooks/sg245196.pdf

Other publications we refer to are as follows:

• OS/400 Work Management, SC41-5306

• AS/400 CL Reference V4R4, SC41-5722

• CL Programming V4R4, SC41-5721

• TCP/IP Configuration and Reference, SC41-5420

• HTTP Server Webmaster's Guide V4R4, GC41-5434

• AS/400 System Operation V3.6.0, SC41-4203

• OS/400 Backup and Recovery V4R4, SC41-5304

• OS/400 Security-Reference, SC41-5302

• AS/400 Alerts Support V4R1, SC41-5413

• Communications Configuration V4R1, SC41-5401

• Basic System Operation, Administration and Problem Handling,
SC41-5206

You can find the AS/400 home page at:

http://www.as400.ibm.com

2.3.1 How to download IBM Redbooks
This section gives you step-by-step instructions of how to download a
redbook onto your computer. Complete the following steps:

1. Go to the home page of the redbook you wish to download.
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2. Right-click View Online.

Figure 3. Selecting the link

3. Select Save Link As.

Figure 4. Starting the “Save Link As...” dialog

4. In the Save As dialog box, choose the directory you wish to save to and
click Save.
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Figure 5. Saving the file

2.4 Future directions

Tivoli is planning additional support for managing AS/400 systems in the next
version of Tivoli IT Director targeted for delivery in the second half of 2000.

For example, you will be able to:

• Automate and schedule software installations on AS/400 systems.

• Monitor jobs and subsystems and have them create alerts (events) if
needed.

• Start, stop, and schedule AS/400 jobs.

• Manage applications via AMP support. For example, AMPs for Lotus
Domino are being developed.

• Transfer files to and from AS/400 systems.

• Enable Monitoring and event filtering for AS/400 message queues.

The 350 MB memory requirement for Tivoli IT Director Management Server
will also be reduced dramatically.

You need to install Adobe Acrobat Reader software on your PC to browse
IBM Redbooks and Redpapers.

Note
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Chapter 3. Tivoli IT Director for AS/400: Planning

This chapter provides information that you should consider before you begin
installing and configuring Tivoli IT Director. IT Director provides
highly-integrated management across the distributed systems and network.
Before installing, you should think about how you will use IT Director and how
you want to manage your IT resources in your environment. IT Director is an
easy way to improve your IT delivery services and management ability to your
IT network. Figure 6 shows an overview of the main functions that IT Director
provides for AS/400.

Figure 6. IT Director main functions

When you implement IT Director in your management environment, you need
to consider both of the following:

• What do you want to manage?

• What functions does IT Director provide?

The following sections provide planning information related to Tivoli IT
Director implementation.

Inventory Resources
Management

Event
Management

Process
Management

easily & quickly
Build your own Inventory queries
Schedule your Inventory queries

easily & quickly
Get all of your IT resources under control
CPU or/and disk usage

easily & quickly
Identify events
Create your own event Action Plans

easily & quickly
View information about processes running on a system
Execute commands on selected systems
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3.1 Implementation planning

To ensure a successful IT Director installation, several prerequisites must be
checked before installing the product on your server or agent machines.
Figure 7 shows the overview of the IT Director implementation planning
processes.

Figure 7. IT Director implementation planning flowchart

As you can see, the following points must be considered when you implement
IT Director:

• Hardware requirements

• Software requirements

• Security value

• Connections between the machines

In 3.2.1, “Hardware requirements” on page 13 and 3.2.2, “Software
requirements” on page 14, you will find the necessary information about the
hardware and software requirements.
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3.2 IT Director installation planning

The IT Director Management Server for AS/400 requires, as a minimum, the
following hardware and software resources.

3.2.1 Hardware requirements
This section describes the hardware requirements of Tivoli IT Director for
AS/400. Since IT Director for AS/400 actually requires a lot of resources
(memory and hard disk) to perform properly, we strongly recommend that you
configure your IT Director Management Server and Agent machines with
sufficient resources.

Table 1 shows the processor features supported for the Tivoli IT Director
Management Server.

Table 1. Processor features supported for the IT Director Server for AS/400

3.2.1.1 Tivoli IT Director Management Server
Before installation, verify the following:

• IT Director Management Server requires only 300 MB of free disk space
and the installation image requires an additional 400 MB of temporary
storage.

AS/400 Model AS/400 Feature

740 2070, 2069

730 2068, 2067, 2066, 2065

720 2064, 2063

170 2388, 2386, 2385

650 2243, 2240

640 2239, 238

530 2162, 2153, 2152

S40 2261, 2256

S30 2260, 2259, 2258

S20 2166

53S 2157, 2156, 2155
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• The user profile used for installation has a value of greater than 440 MB of
free disk space for the maximum allowed storage parameter. You need at
least 740 MB or greater of free disk space.

• 350 MB of RAM.

If you are not sure, use the DSPUSRPRF command (user ID, the profile used for
installation) will show you the maximum storage allowed. This is maximum
amount of auxiliary storage that may be used for objects owned by this
profile. The value is shown in KB.

3.2.1.2 Tivoli IT Director Management Agent
Installation of IT Director Agent for AS/400 requires 62 MB or greater of free
disk space. The agent requires about 10 MB of memory and runs on most
processors.

3.2.2 Software requirements
This section describes the software requirements of the Tivoli IT Director for
AS/400 Management Server and Management Agent.

3.2.2.1 IT Director Management Server
IT Director Management Server requires the following software:

• AS/400 running OS/400 V4R3 or higher:

- OS/400 V4R3 requires the following PTFs (or any PTFs that supersede
these): MF23380, SF60878, PTFs cumulative package C9341430, and
group PTF SF99066.

- OS/400 V4R4 requires PTF SF56068 (or any PTFs that supersedes
SF56068) and the latest group PTF for Java.

If you are installing the Management Server and/or Management Agent on an
AS/400 with V4R4, you must have one of the following installed:

• 5769-JV1 (Option 2) Java Developer Kit 1.1.7

• 5769-JV1 (Option 1) Java Developer Kit 1.1.6

• OS/400 (Option 30) OS/400 - QShell Interpreter

If you are hosting the IT Director Web site on the AS/400 Web server for
AS/400, the IBM HTTP Server for AS/400 (5769-DG1) must be installed and
have access to the file system of the IT Director Management Server.
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3.2.2.2 IT Director Management Agent
Before installing, verify the following:

• AS/400 is running OS/400 V4R3 or higher and the latest cumulative PTFs.

• The user profile used for installation has a value of greater than 38 MB of
free disk space for the maximum allowed storage parameter.

3.2.3 IT Director Management Console
The IT Director Management Console requires the following hardware and
operating systems:

• Windows 95, Windows 98, or Windows NT 4.0 ( Workstation or Server with
Service Pack 3 or higher)

• Pentium class processor

• 32 MB RAM

• 30 MB free disk space

• TCP/IP networking protocol

• A network adapter that supports the TCP/IP networking protocol

The IT Director Management Console performs all IT Director tasks. The IT
Director Management Console can be installed on multiple systems any
where you need or want. See Figure 8 on page 16.

In OS/400 V4R4, the following PTF is highly recommended to improve Java
performance:

5769-999 MF24006

Note
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Figure 8. IT Director Management Console use

The IT Director Management Console is your interface into the Tivoli IT
Director environment. Your IT Director Management Console can
communicate with only one IT Director Management Server at once. Multiple
IT Director Management Consoles can be open at the same time.

3.2.4 Security parameters
This section describes the necessary security parameters for Tivoli IT
Director.

3.2.4.1 Console authorization for the AS/400 Server
On AS/400, an IT Director administrator is defined as a user profile with at
least *USE authority to the ITDADM authorization list. See Figure 9 on page
17.

ITD
Console

AS/400
Agent

AS/400
Agent

AS/400
Server

AS/400
Agent

ITD Console

O perator Ring

router

It is necessary only to grant remote access to users without *ALLOBJ
authority.

Note
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Figure 9. ITDADM Authorization List panel

This authorization list is used by the IT Director Management Server to check
authorities of a logon via an IT Director Management Console.

3.2.4.2 IT Director Management Server authorization list TIVITDSVR
An authorization list is created at the installation. To grant users without
*ALLOBJ authority access to IT Director Management Server commands, you
may add them to the TIVITDSVR authorization list with at least *USE
authority.

For the server, on the command line, type:

WRAUTL TIVITDSVR

Then press Enter.

3.2.5 IT Director Agent authorization list TIVITDAGT
As on the server, an authorization list is created on the AS/400 Agent. To
grant users without *ALLOBJ authority access to IT Director Agent
commands, you may add them to the TIVITDAGT authorization list with at
least *USE authority.

For the agent, on the command line, type:
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WRKAUTl TIVITDAGT

Then press Enter.

The panel in Figure 10 shows the authorization list.

Figure 10. Work with Authorization Lists panel

Select option 2 to edit the authorization list. When this panel appears, use
the F6 function key to add a new user. This object authority user ID must be
set to *USE.
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Figure 11. Add a user to an authorization list (1 of 2)

The *USE authority allows access to the object attributes and use of the
object. The user cannot change the object.

Figure 12. Add a user to an authorization list (2 of 2)
Chapter 3. Tivoli IT Director for AS/400: Planning 19



To authorize an AS/400 user to remotely request access to the Tivoli
Management Agent via the IT Director Management Server, add the user to
the TIVITDAGT authorization list with at least *CHANGE authority.

*CHANGE authority allows a user to request access to the Tivoli
Management Agent through IT Director Management Server. Please refer to
4.3.6, “Requesting access to the AS/400 IT Director Agent” on page 55 for
more information about the request access function.

3.3 Selecting the necessary IT Director features

A chart of the major functions for IT Director Agents that are available on
different operating systems is shown in Table 2.

Table 2. Operating system features comparison

Operating
system

AS/400
V4R3 or
later

Windows
3.11

Windows
95/98

Windows
NT 4.0

OS/2 3.0,
4.0 and
Warp
server

Novell
Netware
3.12, 4.1,
4.11, 5.0

Inventory
Management

YES YES YES YES YES YES

Remote
Control

NO YES YES YES YES NO

Resource
Monitoring

YES YES YES YES YES YES

Event
Management

YES YES YES YES YES YES

Software
Distribution

NO YES YES YES YES NO

File Transfer NO
1

YES YES YES YES YES
2

Process
Management

NO3 YES YES YES YES YES

Task
Scheduling

YES YES YES YES YES YES

Application
Management

NO YES YES YES YES NO

DMI
Management

NO NO YES YES NO NO

CMI
Management

NO NO YES YES NO NO

Cluster
Management

NO NO NO YES NO NO
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As you can see from Table 2, functions, such as MPM Management and DMI
Management, are available primarily for desktop machines. Future versions
of IT Director will add more functions for AS/400, such as process
management and file transfer.

SNMP management is available for every SNMP device and does not require
the installation of IT Director Agent software. The following are examples of
devices that are usually SNMP-enabled:

• Network printers

• Networking routers

• AS/400 servers

For further information about SNMP management, please refer to Chapter 11
in the Tivoli IT Director User’s Guide. For more detailed information, refer to
the Redbook Integration examples of Tivoli IT Director: A First look,
SG24-5207, Chapters 1 and 9.

3.3.1 Creating a solution
A flowchart to help you select an appropriate software solution from Tivoli is
shown in Figure 13 on page 22.

MPM
Management
Client

NO NO YES YES NO NO

SNMP Client
Management

YES YES YES YES YES YES

Notes:
1. File transfer to and from IT Director Management Server is possible, even though server is AS/400.
2. If a NetWare system has DOS drives (A:\, C:\, and so on), these volumes are not displayed in the file system
pane.
3. While processes can not be monitored, commands can be sent to AS/400.

Operating
system

AS/400
V4R3 or
later

Windows
3.11

Windows
95/98

Windows
NT 4.0

OS/2 3.0,
4.0 and
Warp
server

Novell
Netware
3.12, 4.1,
4.11, 5.0

Tivoli IT Director provides an Internet services function. This function is not
applicable to the IT Director Agent (it is an IT Director Management Server
function), so Table 2 does not includes the Internet services function.
Please refer to 5.9, “Internet services” on page 137 for more information
about Internet services.

Note
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Figure 13. Solution selection flowchart

The flowchart contains seven points; here are some clarifications:

1. Find out what your needs are and what kind of OS environment they have
to be addressed in.

2. What are the requirements placed on the software? For example, you
might need software distribution, inventory, and event management.

3. Refer to Table 2 on page 20 and see if the features you need are found.

The following flowchart is only for environments of 1500 machines or less.
If your network is larger than this, Tivoli Enterprise should be chosen over
Tivoli IT Director.

Note

What do you need
to do?

Requirement
A

Requirement
C

Requirement
B

All requirements found in the
features chart?

Use Tivoli
IT Director

Yes

Find a workaround
in the scenario

chapter?

No

Yes

Find an add-on
solution from Tivoli

Web site?

No Yes

Consider Tivoli
Enterprise or

othersNo

See next figure

1

3

2

5

4

7

6
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4. If the features you need are not found in the feature chart, refer to the
scenario chapter of this redbook (and others mentioned in 2.3, “Related
documents and information” on page 8) for a possible workaround.

5. If no solution is found in the scenarios, look for an add-on product that
provides the features you need at the Tivoli IT Director Web site:

http://www.tivoli.com/products/index/it-director/

6. If you answered Yes at any of the points between three and five, your best
choice is the Tivoli IT Director. See Figure 14 for a management scenario
flowchart.

7. In this case, Tivoli Enterprise may be a solution for managing your
environment. Refer to the Tivoli Web site at:

http://www.tivoli.com/

And also refer to the redbook Managing AS/400 with Tivoli Enterprise,
SG24-5517

A simple flowchart demonstrating how to create solutions for Tivoli IT Director
is shown in Figure 14.

Figure 14. Solution design flowchart

As you can see in Figure 14, if you need only one function (such as Inventory
or Remote Control), it can be implemented right away without creating a
scenario to coordinate several functions working together.

Select needed
functions

Design a
scenario

Need only one
function?

No

Implement it
Yes

See next figure for
example
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On the other hand, if you need to create something more complex (such as
Web site-based event monitoring for resources), you should first select the
functions needed, then decide the order and the way in which the functions
should be utilized. An example of this is shown in Figure 15.

Figure 15. Creating your own scenario

With a scenario that has been planned beforehand, you can save time (and,
therefore, money) in implementing IT Director solutions. So, even if you know
how to use each individual function, plan ahead when mixing them.

3.4 Miscellaneous

If the IT Director Management Console is installed on a system that has
AS/400 Client Access installed (AS/400 Client Access Express for Windows
or Client Access for Windows 95/NT V4R4), the IT Director plug-in is added to
the Operations Navigator. Figure 16 on page 25 shows the plug-in that is
added into the Operations Navigator of the IT Director Management Console.
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Figure 16. View from the AS/400 Operations Navigator: Tivoli IT Director plug-in

This plug-in allows you to use the Operations Navigator functions listed
below:

• IT Tivoli Director Management Server (check status, start, end)

• Tivoli Management Agent (check status, start, end)

Please refer to Tivoli IT Director User’s Guide for more information about
using the AS/400 Client Access plug-ins.
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Chapter 4. IT Director for AS/400: Installation and configuration

This chapter describes how to install and configure Tivoli IT Director for
AS/400. We also discuss its basic operations on AS/400. This chapter
provides the following information:

• Creating an IT Director environment.

• The difference between AS/400 and Windows platforms when installing
and configuring IT Director.

• Installing and configuring the Tivoli IT Director for AS/400 even if you are
unfamiliar with the AS/400 environment.

• Uninstalling Tivoli IT Director components.

In this chapter, a sample environment is created as shown in Figure 17.

Figure 17. Sample environment

Before starting the installation and configuration, check the prerequisites for
the IT Director Management Server and Agent. Refer to Chapter 3, “Tivoli IT
Director for AS/400: Planning” on page 11 and the Tivoli IT Director User’s
Guide for more information about IT Director installation planning.
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4.1 Installing the IT Director Management Server

The following sections provide information about the installation and basic
operation of the IT Director Management Server for AS/400 and also provide
tips and considerations about the Tivoli IT Director Management Server
environment. The following is an overview of the IT Director Management
Server installation process:

1. Server software installation

2. Server settings

3. Start server

4. Stop server

The following sections provide detailed information about each installation
step.

4.1.1 Installing the IT Director Management Server software
This section describes how to install IT Director Management Server for
AS/400 software in your AS/400 machine. You need to perform the following
steps:

1. Insert CD2 (for AS/400 software) into the AS/400 CD-ROM drive.

2. Sign on to your AS/400 system. At this time, the user profile should have
user class *SECOFR authority. Ask your AS/400 administrator if you are
not sure about the level of authority.

3. On the AS/400 command line, type the LODRUN command and press the F4
key. See Figure 18 on page 29.
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Figure 18. The LODRUN command

4. In the next screen, enter the device (*OPT for CD-ROM) and directory (for
example, the /server/os400/v4r4/en directory for OS/400 V4R4 English
Version). Refer to Figure 19 on page 30. This sample is based on the
OS/400 V4R4 English Version. If you have installed any other OS/400
versions/releases (V4R3 being the only other choice at the moment), or
other National Language Versions, refer to Chapter 3 of the Tivoli IT
Director User’s Guide.
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Figure 19. The LODRUN command parameters

5. After entering the information, press Enter to start the installation. See
Figure 20 on page 31. After the Decompressing block # of ## countdown
has finished, the installation is complete.
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Figure 20. Installation processing

6. After the installation, you can check whether the software was installed
successfully. Type the DSPSFWRSC command, then press Enter. If the IT
Director Management Server for AS/400 software has been installed
successfully, you can find an entry for the IT Director Management Server
(1ITDSVR). See Figure 21 on page 32.
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Figure 21. The DSPSFWRSC command

4.1.2 Configuring the IT Director Management Server on AS/400
After installing the IT Director Management Server for AS/400 software, you
need to configure and customize the server before starting it. The overview of
this procedure is as follows:

• Set Tivoli IT Director Management Server attributes.

• Set the user profile that will be used as the Tivoli IT Director default user
profile.

The following sections provide detailed information about the configuration
and customization of the IT Director Management Server for AS/400.

On AS/400, the default user profile value configured for the IT Director
Management Server with the Change IT Director Server Attributes
(CHGITDSVRA) command requires *ALLOBJ special authority.

Note
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4.1.2.1 The CHGITDSVRA command
First, you should change the IT Director Management Server attribute
information. On command line, type the CHGITDSVRA command and press the
F4 key. Then, type in your choices for each attribute. Refer to Figure 22. For
more information about the meaning of each parameter, refer to Chapter 3 of
the Tivoli IT Director User’s Guide.

Figure 22. The CHGITDSVRA command

4.1.2.2 The ADDAUTLE command
Before this operation, you should decide what AS/400 user profile will be
used for the IT Director administrator and super administrator. Type the
ADDAUTLE command and press the F4 key. The command prompt screen will
be displayed and you can input information. After you have input the
necessary information, press Enter. See Figure 23 on page 34.

Unless you input the Server License Key information, you can not start the
IT Director Management Server.

Note
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Giving a user *USE authority grants administrator authority, and giving a user
*CHANGE authority grants super-administrator authority.

For more detailed information, refer to the Tivoli IT Director User’s Guide.
Also refer to the AS/400 manual AS/400 Security - Basic V4R5, SC41-5301,
for more information about the authorization list (that concern the ADDAUTLE

command).

Figure 23. The ADDAUTLE command

In this example, the QSECOFR user profile is used as the Tivoli IT Director
super administrator. However, the QSECOFR is a special user profile to
manage the AS/400 system. Therefore, we recommend that you create a
new AS/400 user profile with sufficient authority to manage AS/400
resources and assign this user profile for only IT Director use.

Note
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4.1.3 Starting IT Director Management Server on AS/400
After installation and configuration, you can start the IT Director Management
Server on your AS/400 system. To start the server process, type the
STRITDSVR command and press Enter. See Figure 24.

Figure 24. The STRITDSVR command

After you added a user profile to the authority list using the ADDAUTLE

command, this user profile is added to Console Security with super-user
authority. If you add the IT Director User Account from Console Security,
that user is not added to the authority list on AS/400. For detailed
information about Console Security, refer to the Tivoli IT Director User’s
Guide.

Note
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4.1.4 Stopping IT Director Management Server on AS/400
To stop the IT Director Management Server on your AS/400, type the
ENDITDSVR command on the AS/400 command line, then press Enter. The
stopping server process runs immediately.

4.1.5 Tips and considerations
When installing the IT Director Management Server for AS/400, there are
some tips and considerations for the AS/400 environment. The following
sections introduce these tips and considerations.

Name resolution
Since the IT Director Management Server sometimes searches the IT
Director Management Agent using a host name (for example, if you use
TCPIP::HOSTNAME in event action plans to designate a target system for a
task), TCP/IP name resolution (DNS, host file), or the use of an IP address, is
required in some cases. Refer to the TCP/IP Configuration and Reference
V4R4, SC41-5420, for more detailed information about AS/400 TCP/IP
configurations.

Time zone
The IT Director Management Server refers to the AS/400 system value
QUTCOFFSET. The default value is +0000 (which means UTC). You can
check the current value using the DSPSYSVAL QUTCOFFSET command. If you want
to set another value, type the CHGSYSVAL QUTCOFFSET command and press the
F4 key, then input the proper value and press Enter. See Figure 25 on page
37.

It may take several minutes to start the IT Director Management Server
completely, especially when the server initially starts. If the server is not
started completely, you will experience a failure when trying to log in to the
console.

The message ITD1013 gets sent to the QSYSOPR message queue when
the IT Director Management Server is ready for console login.

Note
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Figure 25. The CHGSYSVAL command

Refer to OS/400 Work Management, SC41-5306, for more detailed
information about AS/400 system values.

4.2 Installing the IT Director Management Console

You need to install the IT Director Management Console software on a
Windows machine (Windows NT, Windows 95/98).

The following sections provide information about installing IT Director
Management Console software on a Windows machine and logging on to the
IT Director Management Server.

4.2.1 IT Director Management Console installation
The actual installation process of the IT Director Management Console has
nothing to do with AS/400. Refer to Chapter 3 of the Tivoli IT Director User’s
Guide for detailed information about the installation process.

If you are using AS/400 Client Access (AS/400 Client Access Express for
Windows or AS/400 Client Access for Windows 95/NT V4R4) and Operations
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Navigator on a PC where you intend to install IT Director Management
Console, the AS/400 Client Access plug-in will be installed automatically. This
plug-in enables you to manage the IT Director Management Server and
Agent. See Figure 26.

The available functions through the plug-in are:

• Start Server/Agent

• Stop Server/Agent

• Check status of Server/Agent

Figure 26. Client Access plug-in

If you install the AS/400 Client Access plug-in after the IT Director
Management Console installation, the plug-in is not added automatically. In
this case, utilizing the plug-in will require some extra settings. Refer to the
Tivoli IT Director User’s Guide for more detailed information.

4.2.2 Logging into the IT Director Management Server
After the IT Director Management Console installation, you can connect and
log in to the IT Director Management Server. See Figure 27 on page 39.
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Refer to Chapter 4 of the Tivoli IT Director User’s Guide for more detailed
information.

Figure 27. IT Director Management Server login screen

4.3 Installing and configuring the IT Director Management Agent

This section provides information about the installation and configuration of
the IT Director Management Agent on AS/400. The following is an overview of
the IT Director Agent installation and configuration procedure:

• Install the Tivoli Management Agent software on local AS/400.

• Install the Tivoli Management Agent software on remote AS/400.

• Configure the Tivoli Management Agent.

• Start the Tivoli Management Agent.

• Stop the Tivoli Management Agent.

• Un-secure the Tivoli Management Agent.

The following sections describe the details about the installation and
configuration of the IT Director Agent on AS/400 systems.

When you log in to the IT Director Management Server, use the user ID and
password that you have been authorized for by the ADDAUTLE command on
the AS/400 system. If you use a different user ID and password, the login
process will fail due to the authorization. Refer to 4.1.2.2, “The ADDAUTLE
command” on page 33 for more detailed information.

Note
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4.3.1 Installing Tivoli Management Agent software on local AS/400
In most of customers’ management environments, you should assume two
different types of installation as follows:

• Local installation

• Remote installation

Figure 28 shows a typical example of a customer’s AS/400 management
environment.

Figure 28. Local systems management and remote systems management

If all managed resources are located in the same place (for example, the
same building or same site), you do not have to perform the remote
installation. However, recently, the management environment has been
getting bigger, and normally, customers must manage some AS/400 systems
remotely. In this redbook, we introduce both ways—the local installation and
remote installation of IT Director Management Agent software on the AS/400
system.
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The following is an overview of the IT Director Agent local installation
procedure:

1. Insert CD2 (for AS/400 software) into the AS/400 CD-ROM drive.

2. Sign on to your AS/400. At this time, the user profile should have user
class *SECOFR authority. Ask your AS/400 administrator if you are unsure
about the level of authority.

3. On the AS/400 command line, type the LODRUN command and press the F4
key.

4. In the next screen, enter the device (*OPT for CD-ROM) and directory (for
example, the /agent/os400/v4r4/en directory for the OS/400 V4R4 English
Version) as shown in Figure 29. This example is based on the OS/400
V4R4 English Version. If you have installed any other OS/400
versions/releases (V4R3 being the only other choice right now), or other
National Language Versions, refer to Chapter 3 of the Tivoli IT Director
User’s Guide for more detailed information.

Figure 29. The LODRUN command prompt

5. After entering the information, press Enter to start the installation. After
the Decompressing block # of ## countdown has finished, the installation
is complete.
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6. After the installation, you can check whether the software has been
successfully installed. Type the DSPSFWRSC command, then press Enter. If
the software has been installed successfully, you can find an entry about
the IT Director Agent (1ITDAGT) as shown in Figure 30.

Figure 30. The DSPSFWRSC command

4.3.2 Installing Tivoli Management Agent software on remote AS/400
In our project, we installed the Tivoli Management Agent software to the local
AS/400 machine (Falcon) first, and then installed the Tivoli Management
Agent software to the remote AS/400 machine (Ralyas4b), which is located in
Raleigh, North Carolina. See Figure 31 on page 43.

If you have installed the Tivoli IT Director Management Agent, the Tivoli
endpoint is also installed automatically.

Please refer to Managing AS/400 with Tivoli Enterprise, SG24-5517 for
more detailed information about Tivoli Enterprise and Tivoli for AS/400
endpoints.

Note
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Figure 31. Remote installation in our test environment

Complete the following steps:

1. First, you need to complete the installation of the Tivoli Management
Agent on a local AS/400 machine (Falcon). Refer to 4.3.1, “Installing Tivoli
Management Agent software on local AS/400” on page 40 for more
detailed information about local installation.

Falcon
(AS/400)

Austin

Ralyas4b
(AS/400)

Raleigh

1.Install
2. Remote Install

Tivoli
Management
Agent

If you have already started Tivoli Management Agent, you need to stop the
Agent process. To stop it, type the ENDITDAGT command and press Enter.

See Figure 32 on page 44.

Note
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Figure 32. The ENDITDAGT command

2. After the installation, create a save file to save the Tivoli Management
Agent software files to a package on the local AS/400 machine. Type the
CTRSAVF command on the AS/400 command line and press the F4 key.
Next, enter the information for save file name and its library and then press
Enter. Refer to Figure 33 on page 45. For more detailed information about
save file (backup and recovery), refer to OS/400 Backup and Recovery
V4R4, SC41-5304.
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Figure 33. The CRTSAVF command

3. Create the save file on the remote AS/400 machine. Follow the same
procedure as with local AS/400. See Figure 34 on page 46.
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Figure 34. The CRTSAVF command on remote AS/400

4. Save the Tivoli Management Agent software on the local AS/400 machine.
Type the SAVLICPGM command on theAS/400 command line and press the
F4 key. Input the information listed below (also refer to Figure 35 on page
47). Then, press Enter.

Product 1ITDAGT. The Tivoli Management Agent software.

Device *SAVF. Save file.

We recommend that you use the same name for the save file and library to
simplify the following processes.

Note
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Figure 35. The SAVLICPGM command (1 of 2)

5. The Parameter screen is extended. Type the extended information into the
save file and library parameter fields. Use the save file and library that you
created in the former process, then press Enter. See Figure 36 on page
48. Now, the saving software process starts.
Chapter 4. IT Director for AS/400: Installation and configuration 47



Figure 36. The SAVLICPGM command (2 of 2)

6. After the saving process, transfer the saved file to the remote AS/400
machine from the local AS/400 machine using FTP. On the local AS/400
machine, type the FTP command on the AS/400 command line and press
the F4 key. On the command prompt screen, type the remote AS/400 host
name or IP address in the Remote system parameter field as shown in
Figure 37 on page 49. For more detailed information about FTP, refer to
TCP/IP Configuration and Reference, SC41-5420.
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Figure 37. The FTP command

7. If the connection to the remote AS/400 is established successfully, you
need to type a valid user ID and password to access the remote system.
First type the user ID and press Enter, then type the password. See Figure
38 on page 50.
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Figure 38. FTP password request screen

8. Type the FTP sub-commands as follows:

> BIN [Change binary mode]
> CD library name [library that holds the save file on remote AS/400]
> LCD library name [library that holds the save file on local AS/400]
> GET save file name (replace [in this example, both files are same
name]

Then, the transfer process is started. After the completion of transfer, type
the QUIT subcommand as follows to exit the FTP program:

> QUIT

See Figure 39 on page 51.
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Figure 39. FTP completion

9. Start the installation process on the remote AS/400 machine. Type the
RSTLICPGM command on the remote AS/400 command line, then press the
F4 key. On the command prompt screen, input the information listed
below:

Product 1ITDAGT

Device *SAVF

Then press Enter. See Figure 40 on page 52.
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Figure 40. The RSTLICPGM command (1 of 2)

10.The parameter screen is extended. Type the extended information into the
save file and library parameter fields. Type the information as listed below.

Save file ITDAGT The save file name.

Library ITDAGTSW The library in which the save file exists.

Then, press Enter. See Figure 41 on page 53. The software installation
process starts.
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Figure 41. The RSTLICPGM command (2 of 2)

11.After the installation, you can check whether the software has been
installed successfully using the DSPSFWRSC command. Refer to Figure 21 on
page 32.

4.3.3 Configuring the Tivoli Management Agent
On the IT Director Management Agent, you need to configure the IT Director
Agent attributes. On the AS/400 command line, type the CHGITDAGTA

command, press the F4 key, and then enter the information. See Figure 42 on
page 54. Refer to Chapter 3 of the Tivoli IT Director User’s Guide for more
information about the meaning of each parameter.
Chapter 4. IT Director for AS/400: Installation and configuration 53



Figure 42. The CHGITDAGTA command

4.3.3.1 Security considerations for Tivoli Management Agent
For security considerations, please refer to 3.2.4, “Security parameters” on
page 16.

4.3.4 Starting the IT Director Management Agent
After the installation and configuration, you can start the Tivoli IT Director
Management Agent. To start the Agent process, type the STRITDAGT command
as shown in Figure 43 on page 55. Normally, the IT Director Management
Agent starting process should not take long compared to the IT Director
Management Server starting process.

The Tivoli IT Director Management Agent also uses the AS/400 system
value QAUTCOFFSET. You need to check the value. For more detailed
information, refer to 4.1.5, “Tips and considerations” on page 36.

Note
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Figure 43. The STRITDAGT command

4.3.5 Stopping the IT Director Management Agent
To stop the Tivoli IT Director Management Agent, type the ENDITDAGT

command on the AS/400 command line, then press Enter. The IT Director
Agent stopping process starts immediately.

4.3.6 Requesting access to the AS/400 IT Director Agent
After the installation and discovery of the IT Director Agent on the AS/400
systems, you will notice that the AS/400 system is displayed with a locked
icon. This is because AS/400 systems are secured by default and you will
have to provide an administrator account name and password to gain access.
To accomplish this, right-click the system icon with the right mouse-button.
Then select Request Access.... See Figure 44 on page 56.
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Figure 44. Requesting access

The screen shown in Figure 45 appears and prompting for a correct user ID
and password.

Figure 45. Inputting administrator account name and password
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The user must have *ALLOBJ authority or have *CHANGE authority to obtain
the TIVITDAGT authorization list. Next, fill in the password and click OK. You
will be notified if the user ID and password are accepted. See Figure 46.

Figure 46. Access request accepted

The AS/400 system is now ready to be managed by the Tivoli IT Director for
AS/400.

4.4 Uninstalling IT Director components

The uninstallation process of the Tivoli IT Director Management Server and
Tivoli Management Agent is performed by the DLTLICPGM command. With this
process, all the items that were created in the installation process are deleted
except the user profiles (TIVITDSVR, TIVITDAGT).

4.4.1 Uninstalling the IT Director Management Server
This section provides information about uninstalling the Tivoli IT Director
Management Server. To uninstall, perform the following steps:

1. If the Tivoli IT Director Management Server is still running, you need to
stop it. Type the ENDITDSVR command on the AS/400 command line, then
press Enter.

2. Type the DLTLICPGM 1ITDSVR command on the AS/400 command line, then
press Enter. The uninstall process starts. See Figure 47 on page 58.
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Figure 47. The DLTLICPGM 1ITDSVR command

After the uninstallation has completed, you will receive a message. See
Figure 48 on page 59.
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Figure 48. Uninstall 1ITDSVR completion

3. You can check the deletion of software using the DSPSFWRSC command.

4.4.2 Uninstalling the IT Director Management Agent
This section provides information about uninstalling the Tivoli Management
Agent. To uninstall, perform the following steps:

1. If the Tivoli Management Agent is still running, you need to stop it. Type
the ENDITDAGT command on the AS/400 command line, then press Enter.

2. Type the DLTLICPGM 1ITDAGT command on the AS/400 command line, then
press Enter. The uninstallation process starts. See Figure 49 on page 60.

In this process, the user profile TIVITDSVR is not deleted. You need to
delete it manually if you do not want to use it in the future.

Note
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Figure 49. The DLTLICPGM 1ITDAGT command

3. If you do not need the Tivoli endpoint, you can also uninstall it. Type the
DLTLICPGM 1TMELCF command as shown in Figure 50 on page 61.
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Figure 50. Delete Tivoli endpoint software

4. You can check that the software has been deleted using the DSPSFWRSC

command.

4.4.3 The DLTITDDTA command
The DLTITDDTA command is common to the Management Server and Agent.
This command deletes the configuration data and database from the AS/400.
The deleted resources are:

• Some files in TIVITDDB library (Server only)

• Some files in /TivoliItdData directory

To use this command, type DLTITDDTA on the AS/400 command line, then
press Enter.

In this process, the user profile TIVITDAGT is not deleted. You need to
delete it manually if you do not want to use it in the future.

Note
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You can only use this command before you uninstall the Management Server
or Agent software.
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Chapter 5. Using Tivoli IT Director for AS/400

Tivoli IT Director Management Server for AS/400 provides a variety of
powerful functions for managing your AS/400s and other machines efficiently.
The following is a list of these functions:

• Inventory management

• Resource monitoring

• Event management

• Software distribution

• File transfer

• SNMP management

• Process management

• Task scheduler

• Internet services

Each function is highly integrated and is easy to use form the Tivoli IT
Director Management Console GUI. This enables customers to implement
management solutions quickly and efficiently. Tivoli IT Director provides
powerful solutions for small-to-medium environments, either by using one
function, or a combination of different functions.

This chapter introduces detailed information about each management
function provided by Tivoli IT Director Management Server for AS/400.

5.1 Inventory management

When Tivoli IT Director is started, the Inventory task begins to collect
inventory data from the discovered nodes. IT Director Inventory management
helps you handle and manage the inventory data of hardware and software
installed on your network. Inventory management can also help you organize
your hardware resources to prepare a migration plan or a software upgrade.

IT Director Inventory Management automatically collects the inventory data
and enables you to display and export it easily. Even though AS/400
information is visible in the general inventory data fields, Tivoli IT Director
Inventory also contains an AS/400 folder for detailed AS/400 inventory. For
instance, there is one AS/400-specific table for hardware information. This
information can be retrieved using the DSPHDWRSC command.
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The cumulative PTF level is in the software table (but it is not an
AS/400-specific table). This information is similar to what is seen on the
AS/400 with the DSPSFWRSC and DSPHDWRSC commands.

• Information related to hardware

- CPU type

- Disk type, size

- Communications adapters

• Information related to software

- Product name

- Version

- Vendor name

All this allows you to move away from the earlier methods of manually
updated inventories, which usually either contained too little data or were out
of date. Figure 51 on page 65 shows the inventory data process flow with
Tivoli IT Director Inventory management.
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Figure 51. Inventory functions overview

In the IT Director management environment, the inventory data is collected
when a managed system is initially discovered and then during regular
intervals. All of this data then becomes valid data for configuring the criteria
for creating a new group. You also can set your own frequency of inventory
collection, for example, daily or weekly.

5.1.1 Performing an inventory collection
Inventory data is collected on all discovered managed systems in your
network at system discovery and during regular intervals. Figure 52 on page
66 shows the IT Director Management Console with the inventory data.
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Figure 52. Starting inventory management

Start the Inventory task by dragging and dropping the Inventory task icon
onto the target machine or a group, or by right-clicking a group and selecting
the View Inventory menu. See Figure 53 on page 67.
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Figure 53. View Inventory selection

5.1.2 The Inventory Query Browser
IT Director Inventory Management provides an Inventory Query Browser. This
window is divided into the following two panels:

• Available Queries

• Query Results

The following describes each panel:

Available Queries This panel contains a custom folder that you can use
to store customized queries that you or others create
and a standard folder of default queries that are
defined for you during the installation.

Query Results This panel displays the results of the queries you
select. The query results include only data that is valid
for the managed systems targeted. For example,
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Windows NT systems do not contain AS/400
components; therefore, they will display nothing in the
AS/400 hardware query. Figure 54 shows the
Inventory Query Results panel.

Figure 54. Query Results panel

When an inventory query is completed, the results are displayed in the Query
Results panel. The results are shown in tabular columns in the order in which
they were defined when the query was originally built.

5.1.3 Building a customized query
There are many useful default queries defined in the standard folder in the
Inventory Query Browser window. If they do not quite match your needs, you
can build your own custom inventory queries using the Inventory Query
Builder window. Drag and drop the desired data items from the Available
Criteria panel, or use the Add and Remove buttons to create your query in
the Selected Criteria panel. You can define the query criteria to be presented
in whatever order you like. You can select entire folders (containing many
different criteria) or individual criteria items from each folder. You can have
multiple folders open at once to add to the query being built.
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To invoke the Inventory Query Builder, select Tasks from the menu bar and
select the Build Custom Query menu. See Figure 55.

Figure 55. Build Custom Query selection

Then, click AS400 Hardware to see the extended Available Criteria as shown
in Figure 56 on page 70.
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Figure 56. Select hardware criteria details

Select the criteria you want to add to the Selected Criteria panel, then click
the Add button. Figure 57 and Figure 58 on page 71 demonstrate how criteria
from different folders (such as Hardware and Software) can be added to
create a single query.

Figure 57. Select software criteria
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First, you just select the folder, then select the criteria and click the Add
button.

Figure 58. Software criteria details

As a result, you will be able to browse the customized query on the IT
Director Management Console as shown in Figure 59 on page 72.
Chapter 5. Using Tivoli IT Director for AS/400 71



Figure 59. Customized query result

Please refer to the Appendix of the Tivoli IT Director User’s Guide for more
information about the IT Director Inventory databases and tables.

5.1.4 Updating the list of available queries
Click the following icon, the refresh queries icon, in the tool bar at the top of
the Inventory Query Browser window to refresh the inventory database.

This icon updates the view to show custom queries created by all users. This
function is helpful if several people are creating queries at the same time.

5.1.5 Modifying inventory collection preferences
You can configure how often inventory data is refreshed as well the response
time for attempted inventory refreshes by selecting Options -> Server
Preferences, and selecting the Inventory Collection Preferences tab. See
Figure 60 and Figure 61 on page 73.
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Figure 60. Options panel

For efficient and helpful Inventory Management, Inventory Collection must be
done at least once a month, especially if you plan to upgrade a part or the
entire network.

Figure 61. Server Preferences panel
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In the Timeout Period Settings field, enter the number of minutes to wait for
an inventory refresh to be completed. If no response is received during this
period, the refresh is abandoned. The default value is 10 minutes.

In the Refresh Interval Settings field, enter the interval of time desired
between automatic refreshes of the inventory database. The default is seven
days.

5.1.6 Using inventory management: Exporting inventory data
Even though the IT Director Inventory task is capable of displaying inventory
data in a readable form, sometimes a need arises to send the data to
someone who does not have access to an IT Director Management Console.
In those cases, the most prudent course of action is to export the data from
the Inventory task.

To do this, you must go to the Inventory task and select the query where you
wish to have the data exported from. Then, you export the query results by
selecting File -> Export.

In this case, Inventory Collection can be scheduled to happen during low
workload periods.

Note
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Figure 62. Exporting the query results

The data can be exported in the following two formats:

• Spreadsheet (.CSV) format

• HTML (.HTM) format

Since HTML is a widely-accepted language and browser software capable of
reading the files is present on most computers, it is wiser to export in this
format by default. But if the data requires modification after export and
suitable spreadsheet software (such as Lotus 1-2-3 or Microsoft Excel) is
present, then a Spreadsheet format should be chosen. After clicking HTML
(or Spreadsheet if necessary) the screen shown in Figure 63 on page 76 will
be displayed.
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Figure 63. File name query screen

Enter a descriptive name in the File Name field (a .htm suffix will be added
automatically), then choose a directory to save the file and click OK.

Figure 64. Export complete

Click OK in the Export Confirmation screen. The file has now been created
with the file name and directory you chose.

5.2 Resource monitoring

The Tivoli IT Director resource monitoring task enables you to view statistics
on critical system resources, for example, CPU utilization, disk space, job
queue status, and so on.
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Using resource monitors, especially when using them in conjunction with
event action plans, can help you prevent problems in your environment that
are caused by lack of resources. For example, it is far more preferable to be
warned that the database server is running out of disk space in advance than
actually finding out the hard way.

Checking all kinds of vital resources can always be accomplished by hand,
but checking 10 different things on 50 different servers can be time
consuming. With resource monitors, you can have the Tivoli IT Director
Management Server perform these checks for you.

As a result, you can perform the following actions:

• Timely warnings of critical resources running out.

• Ability to monitor the status of your resources from the IT Director
Management Console.

• Ability to view resource status from a Web site.

• If combined with event action plans, it provides an ability to automate
responses to low-resource situations, such as cleaning temporary files
and compacting databases.

• A way to monitor your resource usage history.

• A way to do it all on up to 1700 machines as easily as on one.

In Figure 65 on page 78, there is an overview showing how resource monitor
data gathered from Agent machines get translated into events and other data
by the IT Director Management Server and then gets sent to the IT Director
Management Console.
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Figure 65. Overview of resource monitoring

The following sections will help you understand and implement resource
monitors on your AS/400 platform.

5.2.1 Understanding monitors
IT Director monitors use monitoring agents on the managed systems to
enable the gathering of data at the IT Director Management Server.

These monitoring agents gather and forward sampled data to the IT Director
Management Server where it is stored for viewing. Gathered data is
time-stamped and refreshed at regular intervals.
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Figure 66. Monitoring resources

You can start resource monitors by dragging the task to a managed system or
group, or by right-clicking a group or a system and choosing Resource
Monitors.

Monitoring categories are called attributes. For example, the system statistics
monitor function is an expandable attribute with sub-categories.
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Figure 67. Resource monitor attributes

5.2.2 Critical monitors
With many tools, there is the possibility that resource monitors themselves
can become a drain on system resources. IT Director resource monitoring on
the other hand does not use too many resources, but it is still prudent to
choose carefully the attributes you wish to monitor.

We selected five attributes that will give you an overview of the AS/400
system’s resource usage. These are shown in Table 3.

Table 3. Critical monitor attributes

Attribute What does it do?

CPU Utilization, percent (Found under
System statistics)

Shows what percent of the CPU is being
used.

In Version 2.11 of Tivoli IT Director resource monitoring, memory monitors
are not applicable to the AS/400 platform.

Note
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5.2.3 Publishing monitors on the Web site
After you have chosen the attributes to monitor, you can choose to monitor
them on the Systems Management Web site. If you have not created the Web
Site yet, refer to 5.9, “Internet services” on page 137 for information on how to
set up your Web site. If you have set up your Web site, but have not enabled
Monitor Publishing, you must go to Web Site Builder.

In the Web Site Builder window you must select the Enable Monitor
Publishing checkbox under Page Options. See Figure 68 on page 82.

System ASP used, percent (Found under
System statistics)

Shows what percent of the disk space is
being used.

Jobs in system (Found under Job
statistics)

Shows how many jobs are currently
running in the system. If the CPU
utilization is high, it may be due to many
jobs running on the system.

Batch jobs in system (Found under Job
statistics)

Shows the number of batch jobs currently
running in the system. A large number of
batch jobs can also cause high CPU
utilization.

Users signed on (Found under User
statistics)

Number of users currently logged into the
system. The number of users can greatly
affect the number of jobs and batch jobs in
the system.

Attribute What does it do?
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Figure 68. Enabling Monitor Publishing selection

To publish the monitors on the site, start the Resource Monitors task on a
machine or a group and add the attributes you wish to monitor to the
Selected Resources table.
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Figure 69. Publishing monitors on the Web site

After all your attributes have been added to the table, choose Options and
Publish to Web Site.

You will then get a dialog asking for a Monitor Name, Publishing Interval, and
Maximum Web Table Entries.

The number of entries is something you will want to think about. If you only
want to have the latest data, then a few entries will be sufficient, and old ones
will be automatically removed. But, if you wish to be able to see the history as
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well as the current readings, then set the maximum number and publishing
interval, accordingly. With a two hour publishing interval and 240 table
entries, you will get 20 days of history.

Figure 70. Web publisher settings

Click the Save button to publish your monitor. You can now go to the Web site
and view it under the Resource Monitors page.

Figure 71. Selecting the monitor to view
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If you do not have any resource monitors, you should try pressing the Reload
button in your browser or try clearing the cache. When you see the monitor
you created, click its name to open the list of entries.

Figure 72. Selecting the time

Here, you can select from both the present and past monitor entries. Click the
entry you wish to view.
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Figure 73. Monitor data

The screen will show you a time-stamped entry with all of the chosen attribute
values.

5.2.4 Removing monitors from the Web site
To remove a monitor from the Web site, go to the Web Site Builder and click
the Web Monitor Attributes tab. Choose the monitor you wish to remove and
click Delete.
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Figure 74. Removing monitors from the Web site

You when asked to confirm your choice, answer Yes and you will get a
message confirming that the monitor has been removed.
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5.2.5 Available AS/400 attributes
A list of all attributes that are available for the AS/400 platform is shown in
Table 4.

Table 4. All available monitors for AS/400

Category Available attributes

I/O Processors Auxiliary I/O processor use (percent)

IOP all communication use (percent)

IOP disk use (percent)

IOP LAN use (percent)

IOP memory free (KB)

IOP optical use (percent)

IOP SDLC use (percent)

IOP tape use (percent)

IOP twinaxial use (percent)

IOP operational status

IOP system function use (percent)

Primary I/O processor use (percent)

Job Queues Job queue status

Jobs in queue

Job Statistics Batch jobs ended, output waiting

Batch jobs ending

Batch jobs held on job queue

Batch jobs held while running

Batch jobs on held job queue

Batch jobs on unassigned job queue

Batch jobs running

Batch jobs waiting for messages

Batch jobs waiting to run

Jobs in system
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NetServer Statistics Average response time (milliseconds)

Duplicate sessions

File opens/minute

Kbytes received per minute

Kbytes sent per minute

Password violations

Print jobs queued/minute

Session errors/minute

Session starts/minute

Physical Disks Disk arm utilization (percent)

Disk average queue length

Disk mirroring status

Disk operational status

Disk processor utilization (percent)

Disk read commands/minute

Disk read Kbytes/minute

Disk space free (MB)

Disk space used (percent)

Disk write commands/minute

Disk write Kbytes/minute

Storage Pools Active to ineligible (transitions/minute)

Active to wait (transitions/minute)

Database faults per second

Database pages per second

Non-database faults per second

Non-database pages per second

Wait to ineligible (transitions/minute)

Category Available attributes
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5.3 Event management

The Tivoli IT Director enables you to identify, categorize and handle events
that you get from your managed network. These events can be categorized in
the events filters—you can select the level of the severity and link those to
event action plans. Using event action plans with resource monitoring allows
you to manage a large network of Agents from a single point. You can
manage from anywhere and at anytime.

Subsystems Subsystem percent of job limit

Subsystem active jobs

Subsystem status

System Statistics CPU utilization (percent)

Current temp storage used (MB)

Max temp storage used (MB)

Permanent addresses used (percent)

System ASP used (percent)

Temporary addresses used (percent)

User Statistics Users disconnected

Users signed off, output waiting

Users signed on

Users suspended by group jobs

Users suspended by system request

Category Available attributes
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Figure 75. Event management

Event management consists of the following:

• An event is a message stating that something has happened on the
managed system. It contains severity and event type information.

• An event filter describes a set of characteristics (for example, severity and
event type), and if those characteristics are found in an event, the event is
passed on through the filter to the actions.

• Actions define the steps to take in response to an event.

• An event action plan binds an event filter to one or more actions. For
example, an event action plan can be created to send a page to the
network administrator pager’s, an e-mail message to a pool of
administrators, or an event message on a Web page.

5.3.1 Understanding event management
The event management task consists of three components:

• Creating a new event action plan
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• Creating new event filters

• Creating new actions

Using the Event Action Plan Builder, you can create new event action plans
and event filters, and customize actions.

Figure 76. Event Action Plan Builder icon

Event filters and customized actions can then be logically associated to form
an event action plan.
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Figure 77. Create a new Event Action Plan

The main area of the Event Action Plan Builder contains three panels:

• Event Action Plan contains all of the defined event actions plans.

• Event Filters contains the list of predefined and user-created event filters
available to assign to an event action plan.

• Actions contains the list of generic actions offered by the IT Director.

To build a new event action plan, you can drag one or more event filters from
the Event Filters panel and drop them on the desired Event Action Plan icon.

5.3.2 Using predefined event filters
Predefined event filters are supplied by IT Director and listed in the Event
Filters panel. They are designed to meet many of the basic monitoring
requirements. But to meet customized demands, it is always recommended
that you create your own event filters.

5.3.3 Creating an event filter
IT Director provides the event filter builder facility to create your own filters. To
create a filter, you choose one or more event categories from the dialog
window. See Figure 78.
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Figure 78. Dragging Event Filters to Event Actions Plans

To create a customized action, right-click on the action you wish to customize
and select Customize. A dialog box will appear and you can input the
customized data in it. When you are done, select File -> Save and give the
action a descriptive name.
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Figure 79. Add an Action to Event Filters

Then, drag one or more customized actions from the Actions panel onto the
event filter.

The drag and drop function is one-directional—you can drag actions and
filters to event actions plan, but you cannot drag an event action plan icon
over to an event filter or action.

5.3.4 Event action plan example
In this section, we receive an event from an AS/400. This event comes from a
message sent to the QSYSOPR message queue and routed to the IT Director
Management Console. The following shows a Control Language Program
example. To avoid many messages, we select only message IDs with the
Alert attributes other than *NO. The Alert option is specified in the Message
description and this value will be displayed by using the DSPMSGD command.
The values are:

*NO No alert is sent.

*IMMED An alert is sent immediately, simultaneous with sending the
message to QHST and/or QSYSOPR.

*UNATTEND An alert is sent immediately only when the system is running
in unattended mode.
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*DEFER The alert is sent after local problem analysis.

The following screen shows an example of a Control Language Program.

The GENEVENT command sends events to the IT Director.

• Parameter Type is a variable that contains the first level message text.

• Parameter Text is mandatory. In this example, the message ID is sent.

To define the severity, retrieve the severity code from the message
description. These codes are used to handle the severity code of the event.
The code has a two-digit value ranging from 00 through 99. The higher the
value, the more severe or important the condition. Table 5 can help you
handle severity codes.

Table 5. Message ID and severity code

Severity code of the MSG ID Severity code of GENEVENT

Less than or equal to 30 Harmless

Less than or equal to 50 Minor

Less than or equal to 70 Warning

Equal to or greater than 80 Critical

PGM
DCL &MSGID *CHAR 7
DCL &MSGDTA *CHAR 132
DCL &MSGF *CHAR 10
DCL &MSGFLIB *CHAR 10
DCL &MSGLEN *DEC LEN(5 0)
DCL &MSGTXT *CHAR 132
DCL &MSGALR *CHAR 9
DCL &EVENT *CHAR 160

/* Receive Message from QSYSOPR MSGQ */
RCVMSG MSGQ(QSYSOPR) MSGTYPE(*LAST) RMV(*NO) +

MSGDTA(&MSGDTA) MSGID(&MSGID) MSGF(&MSGF) +
MSGFLIB(&MSGFLIB)

/* Retreive Message Attributes */
RTVMSG MSGID(&MSGID) MSGF(&MSGF) MSGDTA(&MSGDTA) +

MSG(&MSGTXT) MSGLEN(&MSGLEN) ALROPT(&MSGALR)
/* Generate an Event If the message is Alertable */
IF COND(&MSGALR *NE '*NO') THEN(DO)
CHGVAR VAR(&EVENT) VALUE('AS/400.' *CAT &MSGTXT +

*CAT '.')
GENEVENT TYPE(&MSGID) TEXT(&EVENT) SEV(*WARNING)
ENDDO
ENDPGM
96 Managing AS/400 with Tivoli IT Director



This command can be used in both environments—Interactive or Batch. This
command also can be used to monitor CLP commands and send an event to
the IT Director. Refer to the examples in Chapter 6, “AS/400 management
scenarios” on page 147.

• The identifiers of the escape, notify, and status messages that can be sent
by the CL commands are described in AS/400 Programming Reference
Summary V4R4, SX41-5720

To begin creating the event action plan, open the Event Action Plan Builder,
and if you have not already done so, create a new plan. We named ours
AS/400 Job Failures Event. Next, you have to create a new filter. Right-click in
the Event Filters section of the builder and from the New menu select Simple
Event Filter.

Figure 80. Creating a new Event Filter

The Simple Event Filter Builder: New screen will appear. Under the Event
Type tab, select AS/400 (if you do not find this entry, you have not had any
error messages from your AS/400 yet, or you have set up the AS/400 batch
job incorrectly). Then select File -> Save As.
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Name the filter AS400 Events. Then, drag and drop the newly created filter
onto the AS/400 Job Failures Event plan.

Next, create an action to send the event information to the Web site.
Right-click on the Publish to the System Management Web Site icon and
select Customize.

Figure 81. Customizing a Web message

Give it the title of AS/400 General event message, and the lifespan should be at
least 96 hours. The Body field can be left empty. This enables the use of this
single customized message in all AS/400 event messages.

Next, you need to drag and drop the newly created message onto the filter
that you earlier placed under the plan.
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Figure 82. Adding the action to the plan

Now that you have completed the plan, you must move to the main console to
assign the plan to a machine.

This is done by opening the Event Action Plans in the Tasks pane and then
dragging and dropping the AS/400 Job Failures Event onto the target
system (in this case, EAGLE).

The target does not have to be a single machine; you can assign the same
plan to more than one machine or a group. But the same batch job you
created earlier must be on each of those machines.

Note
Chapter 5. Using Tivoli IT Director for AS/400 99



Figure 83. Implementing the plan on a machine

You have now implemented the plan. After you get an event on the AS/400,
the information will be visible on the Web site.
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Figure 84. Viewing the event messages from the Web site

As you can see in Figure 84, the difference between these messages is in the
Type part of the message. The System Name field shows where the message
originated—a handy piece of information if you are running this plan on
several machines.

5.4 Software distribution

While software distribution to AS/400 systems is not supported in this version
of IT Director (see 2.4, “Future directions” on page 10 for more information on
features in upcoming versions), you are able to distribute software to other
operating systems, and you will also be able to use AS/400 systems as
redirector servers.
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For general information about software distribution, please refer to Chapter 9
of Tivoli IT Director User’s Guide. And for detailed information, refer to the
redbook Software Distribution with Tivoli IT Director, SG24-5493.

Some advantages of software distribution are:

• By creating one package, you can distribute by drag and drop to as many
systems as you want.

• Scheduled distributions.

• Detailed logs on job progress.

• Ability to distribute software via the Web site.

• Redirector servers save your WAN bandwidth.

Figure 85 on page 103 shows an overview of the software distribution
process, showing both a direct (IT Director Server to Agent) installation and
redirected (IT Director Server to redirector to Agent) installation. Since the
latter process stores the software package in the remote subnet, only one
transmission across the WAN is needed.
102 Managing AS/400 with Tivoli IT Director



Figure 85. Overview of the software distribution process

The following sections demonstrate in practice the capabilities of software
distribution.

5.4.1 Redirector servers
Redirector servers act as local storage of software packages in your remote
networks, thus conserving valuable WAN bandwidth. For more information
about configuring redirector servers with an AS/400 as the IT Director
Management Server, please refer to 6.3, “Redirection from AS/400 ITD
Server to NT redirector” on page 158 or 6.4, “Redirection from AS/400 ITD
Server to AS/400 redirector” on page 173.

5.4.2 Distributing the software package in a Web site
Because software distribution is not yet available for AS/400, you can find
detailed and up-to-date instructions in Chapter 9 of the Tivoli IT Director
User’s Guide.
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5.4.3 Distributing Client Access Express for Windows 95 and NT
Since software distribution to AS/400 is not supported in Version 2.11 of IT
Director, we instead provide an example of Client Access software
distribution to desktop machines.

You will need the AS/400 Client Access Express CD-ROM or access to the
installation files a local or remote drive. For this example, we used the
CD-ROM with Z: as the CD-ROM drive letter.

The creation and distribution of the software package has three phases:

• Record installation preferences

• Create the package

• Distribute the package

5.4.3.1 Record installation preferences
AS/400 Client Access Express for Windows is installed using the InstallShield
software, which supports the recording. This means that you have to install
the software on a computer while recording all your choices. This way, you
create a response file that can then be used by IT Director to automate the
installation to other machines.

To begin, go to the Start menu and click Run. The dialog box shown in Figure
86 is displayed.

Figure 86. Starting the installation

Instead of just running z:\express\setup for normal installation, enable the
recording with the -r switch and designate the name and path of the
response file after the -f1 switch. As shown in Figure 86, we used the default
file name of setup.iss. Click OK to start the installation.
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During installation, specify any settings and select any type of installation and
combination of components you desire. These will be replicated on all
machines that you use this installation package on.

Figure 87. Selecting settings and installed components

After you have selected all the options, the installation will start.

Specifying a read-only path (such as a CD-ROM) for the response file will
lead to the file not being created.

Note
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Figure 88. Setup is running

After setup finishes, you will be asked if you wish to restart your machine now
or later. This option is also recorded and will be replicated in every
installation.

If you have a setup.iss file in your c:\temp directory (or whatever directory you
specified after the -f1 switch), you have successfully created a recording of an
installation.

5.4.3.2 Create the package
Now that the response file has been created, go to your IT Director
Management Console and double-click Software Distribution to start the
Software Distribution Manager. See Figure 89 on page 107.
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Figure 89. Starting the Software Distribution Manager

In the Software Distribution Manager window, open the Wizards folder and
double-click InstallShield. This will open a program that guides you through
the package creation process. See Figure 90 on page 108.
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Figure 90. Starting the InstallShield Wizard

In the first screen of the Wizard, you must input the location of the installation
files (in this case, the original CD-ROM) and the location of the response file.

Figure 91. Inputting file locations

When you are done, click the Next button to proceed to the next window.
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Next, you can set the package name (we left the default name in place, you
might want to rename it to better suit your naming conventions). You can also
choose to publish this package in a Web site (for more information on Web
services, refer to 5.9, “Internet services” on page 137). No additional
command line parameters are required for this installation.

Figure 92. Package settings

Click the Platforms button to choose which platforms will be supported by
this installation package.

This installation of Client Access Express is only for Windows 95 and NT, so
uncheck the box beside Windows 3.1 and click OK, as shown in Figure 93 on
page 110.
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Figure 93. Selecting Target Platforms dialog

You are then returned to the Build InstallShield Package window. Choose
Finish to start the creation of the package.

Figure 94. Package creation is running

The length of this phase varies according to the speed of your server and the
size of the installation files. It generally takes about 5 to 10 minutes.

When the window disappears, the package creation is done.

5.4.3.3 Distribute the package
Now that the package has been created, you can start distributing software to
client machines. Start by selecting the package you just created from
software distribution and drag and drop it onto the target machine(s).
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Figure 95. Starting distribution

You can also drag and drop the package onto a group, such as Systems with
Windows NT. This will distribute the software to all systems within the group.

You will then be asked if you wish to schedule this task to happen later or if
you wish to execute the task now. If you choose to use the scheduler, please
refer to 5.8, “Task scheduler” on page 129. Otherwise, choose Execute Now.

Figure 96. Choosing an execution time
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After choosing Execute Now, the distribution status window is displayed. In
this window, you can follow the status of the distribution. If you wish to get
more details of the distribution, right-click on the machine you wish to follow
and select View System Log as shown in Figure 97.

Figure 97. Viewing distribution status

By default, the system log window will not give you detailed information. But
you can change this from the View menu under Detail. See Figure 98 on
page 113.
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Figure 98. Setting the level of detail

The information will not refresh automatically unless you choose Dynamic
Update from the View menu. If you wish to update the information manually,
you can click the Refresh icon shown in Figure 99.

Figure 99. Refreshing manually

After the installation is finished, machine(s) that report completion of the task
are shown under the Complete group. See Figure 100 on page 114.
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Figure 100. Installation complete

You have now installed Client Access Express on the target machine(s).

5.5 File transfer

The file transfer task enables you to transfer files from multiple locations. You
also can delete files, create new directories, and so on.

You can transfer files and directories between:

• The IT Director Management Console local system and the IT Director
Management Server system.

• The IT Director Management Console local system and a native managed
system.

• The IT Director Management Server system and a native managed
system.

An example is shown in Figure 101 on page 115.

The file transfer task is not supported on the AS/400 version of IT Director
Agent, but you can transfer files to and from the IT Director Management
Server even if the server is the AS/400 version.

Note
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Figure 101. File transfer task overview

For information about the use of the file transfer task on other versions of the
IT Director Agent, refer to Chapter 10 of the Tivoli IT Director User’s Guide.

5.5.1 File transfer task example
This section describes an example of a file transfer task. A file will be
transferred from the Tivoli Management Agent on Windows NT to the IT
Director Management Server on AS/400. A new directory is also created on
the IT Director Management Server. See Figure 102.

Figure 102. File transfer example
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Complete the following steps:

1. On the IT Director Management Console, right-click the machine that you
wish to be the other party in the file transfer task (the other is the local IT
Director Management Console system by default, but this can be changed
to the IT Director Management Server), and select File Transfer. See
Figure 103.

Figure 103. File Transfer selection

2. The File Transfer window will be displayed, and you can select the Source
File System and Target File System. In this example, the IT Director
Management Server (AS/400) is the Source File system and AUSRES39
(Windows NT Agent) is the Target File System. You can use drag and drop
to transfer the file(s), or a directory. See Figure 104 on page 117.
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Figure 104. File Transfer window

3. After the transfer starts, status window appears, and you see the file
transfer progress as shown in Figure 105.

Figure 105. File transfer status window

4. To create a new directory, right-click on the directory that you want to
create and select Create Directory. See Figure 106 on page 118.
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Figure 106. Creating a new directory

5. The transferred file and the newly created directory is then shown in the
window. See Figure 107.

Figure 107. Completion of file transfer
118 Managing AS/400 with Tivoli IT Director



The file transfer task is not supported on the AS/400 version of the IT Director
Agent, but you can transfer files to and from the IT Director Management
Server even if the server is the AS/400 version. There is also a workaround in
the scenario chapter in 6.5, “File transfer to and from AS/400: A workaround”
on page 181.

For information about the use of the file transfer task on other versions of the
IT Director Agent, please refer to Chapter 10 of the Tivoli IT Director User's
Guide.

5.6 SNMP management

Simple Network Management Protocol (SNMP) enables you to perform
inventory management, resource monitoring, and event management for
network devices, such as HUBs, routers, network servers, and network
printers. AS/400 is an SNMP-enabled system by default.

Please refer to Chapter 11 of the Tivoli IT Director User’s Guide for more
information about SNMP management.

For advanced SNMP management in the IT Director environment, Tivoli
provides a product called Tivoli Netview IT Director Edition. Refer to the
following URL for more information about this product:

http://www.tivoli.com/products/index/it-director_netview/index.html

Normally, you will have two different representations of the same AS/400
machine in IT Director:

When you transfer a file or a directory to the IT Director Management
Server on AS/400, or create a new directory on it, the file transfer is done
by the default user profile (set it using the CHGITDSVRA command). But
directory management (transferring a directory and creating a new
directory) is done by the TIVITDSVR user profile. If you transfer a directory
containing files, directory transfer (create) is done by the TIVITDSVR
profile and the files are created by the default user profile. This user profile
is the object’s owner. For more detail about object ownership, refer to
OS/400 Security - Reference, SC41-5302.

Note
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This icon represents AS/400 Tivoli Management Agent.

This icon represents SNMP object icon.

For example, if you want to have the resource monitors task target, which has
the SNMP attributes of the AS/400 machine, you must drag and drop the
resource manager on the SNMP icon (or right-click on the icon and choose
Resource Monitors).

You can use the resource monitor as usual, the only difference will be the
attributes as shown in Figure 108.

Figure 108. SNMP resource monitors
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SNMP resource monitor attributes example
The same principle applies to all other tasks. If you wish to target the AS/400
system(s), use the AS/400 icon or group as a target, and if you wish to target
SNMP device(s), use the SNMP icon or group as a target.

5.6.1 AS/400 SNMP settings
As previously mentioned, you can use the AS/400s SNMP services by
default. SNMP starts automatically if AS/400 TCP/IP is active. If you cannot
find AS/400 SNMP devices on the console, please perform the following.

Type the NETSTAT *CNN command on the AS/400 command line. You will then
see the AS/400 TCP/IP Connection Status screen. Check that the local port
column snmp entry exists as shown in Figure 109.

Figure 109. AS/400 TCP/IP Connection Status screen

If you cannot find the SNMP entry, the SNMP service is not starting properly.
To start the SNMP service manually, type STRTCPSVR *SNMP on the AS/400
command line. After submitting the command, check again whether the snmp
service is active.
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For details about the AS/400 SNMP service, refer to Simple Network
Management Protocol (SNMP) Support V4R1, SC41-5412.

5.7 Process management

Tivoli IT Director enables you to manage individual processes on remote
systems. The process management task enables you to start and (when used
in conjunction with the Scheduler task) schedule the task. See Figure 110.

Figure 110. Process Management task

5.7.1 Executing commands on selected systems
You can use the process management task to execute a command on a target
managed system. You can do this by first creating a customized command
and dragging and dropping from the Process Management panel onto the
target system(s).

Only the process task function is available for AS/400 IT Director
Management Agents.

Note
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5.7.2 Creating a non-interactive task
You can use the process management task to send individual commands to a
selected system or group. You can send only one command at time. However,
additional commands are queued on the target systems and executed in the
same order as received. The command can be executed immediately or be
scheduled.

The command for AS/400 must be quoted. The command is interpreted on
the AS/400 by Qshell.

An example of an AS/400 command is:

SYSTEM “CALL MYLIB/MYPGM PARM(‘PARM1’)”

Because the CLP syntax is not checked, you can use copy and paste
functions from the AS/400 command line and paste (CTL + V) to the IT
Director task command line panel.

Figure 111. Process command

Figure 111 shows you how the task is processed by the AS/400.

Task jobs are submitted by the TIVITDSRV Tivoli IT Director Management
Server user, and this user profile has the following special authorities:

• *JOBCTL

• *ALLOBJ

Please refer to the OS/400 Security - Reference, SC41-5302, for more
information about special authorities. Refer to the following job log for more
information about task management in AS/400.

ITD
Console

Cl commands

AS/400
Agent

Job QZSHSH

User: TIVITDSVR.

Exec Cmd

SBS QSYSWRK

Return code
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Jobs are running in the QSYSWRK subsystem, and the type of job is BCI
Batch Immediate.

The TIVITDSVR user profile is not used for process management tasks.
The user profile used is the default user profile configured for the agent on
CHGITDAGTA. If you do not configure a default user profile with the CHGITDAGTA

command, process management tasks cannot be executed “anonymously”
(without a user ID and password).

You must specify a user ID and password for the task in this configuration.

Note

Job Log EAGLE 03/07/00 15:43:08
QZSHSH User . . ... . : TIVITDSVR Number . . . . . . . . . .
TIVITDSVR Library . . . . . : TIVITDSVR
SEV DATE TIME FROM PGM LIBRARY INST TO PGM
00 03/07/00 15:40:56 QWTPIIPP QSYS 05E5 *EXT
Thread . . . . : 00000480
Message . . . . : Job 006125/TIVITDSVR/QZSHSH started on 03/07/00 at
15:40:55 in subsystem QSYSWRK in QSYS. Job entered system on 03/07/00 at
15:40:55.

00 03/07/00 15:42:00 QMHQCRTQ QSYS 00C7 QC2SYS
To module . . . . . . . . . : QC2SYS
To procedure . . . . . . . : system
Statement . . . . . . . . . : 6
Thread . . . . : 00000481
Message . . . . : Object EVT1006125 type *DTAQ created in library TIVITDS

10 03/07/00 15:42:51 QLEAWI QSYS *STMT QZSHSH
From module . . . . . . . . : QLEPM
From procedure . . . . . . : Q LE leBdyEpilog
Statement . . . . . . . . . : 788
To module . . . . . . . . . : QZSHSH
To procedure . . . . . . . : _CXX_PEP
Statement . . . . . . . . . : 37
Thread . . . . : 00000480
Message . . . . : This job is about to end.
Cause . . . . . : The job is being terminated because the job is capable
having multiple threads and the application has issued an exit(), abort()
their equivalent APIs, or an exception has occurred and is not being
handled.

00 03/07/00 15:43:02 QWTMCEOJ QSYS 00AA *EXT
Thread . . . . : 00000480
Message . . . . : Job 006125/TIVITDSVR/QZSHSH ended on 03/07/00 at 15:43:
9 seconds used; end code 0 .

More...
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Figure 112. Send a command

If you select the log option, the Timeout field is enabled. You can specify the
timeout value in seconds.

Figure 113. Save the command

Give a descriptive name for the task. Click File and then View log to get a log
display. See Figure 114 on page 126.
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Figure 114. Executing commands on selected systems

Use normal drag-and-drop techniques to process your command on a group
of managed systems.

Figure 115. Execute Now button

5.7.3 The execution history window
This window provides execution statistics on the task you have just run. See
Figure 116 on page 127.
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Figure 116. Execution history window

Select View to see function availability:

Refresh Immediately refreshes the list of entries each time a new
entry is generated.

Dynamic Update Specifies that the list must automatically refresh.

The log is available in three detail levels:

Low Displays basic information.

Medium Displays the same information as the Low level detail and more
entries depending on the task.

High Displays all entries available for the task.

To update the log, click the Refresh button.

5.7.4 Scheduling a task
You can also schedule a task or define it to repeat automatically at a given
intervals. A scheduled task is called a job.

Most AS/400s have their own scheduler, but you can use or grant the
authority to use this scheduler, for example, to the account group leader to
select a target systems and schedule user queries, or to modify an entry in
your scheduler. See Figure 117 on page 128.
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Figure 117. Schedule a task

In the Scheduled Job field, enter a title for the scheduled job. Enter the date
or click the icon to select the date. If you want to repeat the execution or set
special execution, select Advanced. You can select the type of event to be
generated for this scheduled job during the process or when the job is
completed. See Figure 118.

Figure 118. New Scheduled Job window

The Advanced option allows you to define how to proceed with the scheduled
job.

Under Options, you can define the following:

Delay Execution on unavailable systems: If this option is not selected, only
target systems that are online at the time of execution will have the task
performed on them. Any target system that is offline is assigned to the
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Unavailable status. When all systems have been marked with a Complete or
Unavailable status, the overall status is changed from In progress to
Complete. You can also define how long you want keep the job information in
the log; the default value is the last five executions.

For each scheduled job, you can generate an event. Refer to the IT Director
Online Help for more details.

5.8 Task scheduler

In Version 2.11 of the Tivoli IT Director Management Server, the scheduler
task supports the scheduling of all tasks on the agents that are supported on
their respective operating systems.

You can get general information about how to use the task scheduler on all
operating systems in Chapter 16 of the Tivoli IT Director User’s Guide. In this
section, we provide an example of how to schedule a command to run on an
AS/400 machine.

The following are task scheduler functions:

• Gives you the ability to schedule a task for one or more executions.

• Allows multiple machines to be targeted with a single job.

• Can create events on failure and/or success of job, enabling an automated
process to move from one task to another only if the previous one was
successful.

• Allows for delayed execution if the system is not available (for example,
portable computers can often be out of the office environment).

• Allows you to view the status of upcoming or active jobs.

• Lets you view the log on jobs that are in progress or complete.

Figure 119 on page 130 shows an overview of the task scheduling process.
You give the task (for example, run inventory on all Windows NT machines)
and time of the execution from the IT Director Management Console to the IT
Director Management Server. The server then stores the data in the
scheduler task. At the given time, scheduler runs the task on the target
machine(s).
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Figure 119. Overview of the scheduler task

In the next section, we introduce a practical example of task scheduler use.

5.8.1 Scheduling a command
First, you must create the task by using the Process Task panel under
Process Management. Here, right-click on Process Management and select
Open. In Figure 120, we created a task that will print the contents of the
AS/400 problem logs into its job log.

Figure 120. Task settings

In the Login section, you must provide a user ID and password that have the
right to execute the command on the target system. If you wish to run the
same command on many systems, and you do not have one centralized user
ID and password for all machines, you will have to create several tasks, each

ITD Console

Task and
time of

execution

ITD Server

Scheduler Task

Task

Agent Machines
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with its own set of user IDs and passwords. Also, be sure to check the Log
checkbox.

After you have finished with your settings, select File and Save.

Now you are ready to schedule the task. As shown in Figure 121, click the
Scheduler icon in the IT Director Management Console.

Figure 121. Starting the scheduler task

In scheduler, you can see all past and future tasks. You need to create a new
scheduled job. To do this, you must select File and then New Job. See Figure
122 on page 132.
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Figure 122. Creating a scheduled job

In the New Scheduled Job screen, there are four tabs:

• Date/Time

• Task

• Targets

• Options

First, you need to set the date and time for the job as shown in Figure 123 on
page 133.
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Figure 123. Setting the date and time for the job execution

You can use the calendar as an aid in picking the date.

Next, you need to select the task you wish to perform. Click the Task tab See
Figure 124 on page 134.
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Figure 124. Selecting the task

You will find the task you created earlier by opening Process Management
and Process Tasks. Either drag and drop the task in the Selected Task box
or click it once and then click the Select button.

Now, all that remains to be done is selecting the target(s). To start, click the
Targets tab. See Figure 125 on page 135.
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Figure 125. Selecting target system(s) and saving the job

You can specify a group (such as IT Director AS/400 Systems) as a target or
you can specify a list of systems as targets. Select whichever system(s) you
wish to target and click the Add button. Next, select File -> Save As.

In the dialog box shown in Figure 126, give the job a name. Later, you might
have to pick this job out of hundreds of selections, so it helps if the name is
descriptive.

Figure 126. Naming the job

The job is now scheduled for execution on the time and date of your selection.

Later, you can view the results in the job log. You can find this in the
Scheduler panel under the Jobs tab. You will see a list of all jobs, those that
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have already been executed, those that are running and those that will be run
in the future.

Select the job that you created earlier, in this case, Print problem. Right-click
on the job and select View Log as shown in Figure 127.

Figure 127. Viewing the results from the job log

You will then get a screen that shows you the job’s output. Some output might
be missing the information in the low detail mode, so you should select View
-> Detail -> High as shown in Figure 128 on page 137.
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Figure 128. Job log contents

This is only one way to use the scheduler. Please refer to Chapter 16 of the
Tivoli IT Director User’s Guide for more information. For more examples, refer
to Chapter 5 of Tivoli IT Director Automation, SG24-5295.

5.9 Internet services

Internet services enable you to publish functions of the Tivoli IT Director
Management Server on a HTTP server. The following functions are available
in Internet services:

• Resource monitoring

• Event management

• Software distribution

You can use these functions from a Web browser, such as Netscape or
Internet Explorer. Internet settings for each function are explained in their
respective sections. See Figure 129 on page 138 for an overview of Internet
services.
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Figure 129. Internet services overview

5.9.1 AS/400 HTTP server setup
Before you configure Internet services, you need to configure the OS/400
HTTP server.

This section provides an example of OS/400 HTTP server setup. For more
detailed information about the OS/400 HTTP server, refer to HTTP Server
Webmaster's Guide V4R4, GC41-5434. Complete the following steps:

1. Type the WRKHTTPCFG command on the AS/400 command line and press the
F4 key.

2. On the parameter screen, keep the Configuration name parameter at its
default value (CONFIG), then press Enter. See Figure 130 on page 139.

ITD Server

OS/400

HTML files

publish

Internet services

Console

AS/400

ITD Agent

Windows

Web browser

Resource monitoring
Event management
Software distribution HTTP

server

If you use the software distribution task from a Web browser, you will need
to have the IT Director Management Agent installed on your PC.

Note
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Figure 130. The WRKHTTPCFG command

3. Look for the Pass entry by pressing the Page Down key. See Figure 131 on
page 140.

CONFIG is a default configuration file for the OS/400 HTTP server. You can
also create a new HTTP server configuration. In this example, CONFIG is
used for the OS/400 HTTP server.

Note
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Figure 131. HTTP server config file

4. In the Opt column on the line that is next to the Pass entry line, type 13 and
press Enter. See Figure 132 on page 141.
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Figure 132. Adding an entry to the config file

5. In the Insert HTTP Configuration Entry screen enter the directory
information. The format is as follows:

pass /virtual-directory/* /actual-directory/*

In this example, the directory itdweb is both a virtual and an actual
directory.

Then, press Enter. See Figure 133 on page 142.

You need to create a directory (actual directory) for the Internet service
HTML files in advance. You also need to give authority to access the
directory (use the QTMHTTP user profile). For more detailed information,
refer to the HTTP Server Webmaster's Guide V4R4, GC41-5434.

Note
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Figure 133. Pass entry format

6. To check that the new entry was added properly, see if the line with the
Pass entry has the correct information (see the example in Figure 134 on
page 143). Then, press the F3 key to exit this screen.
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Figure 134. New entry added

7. If the OS/400 HTTP server has already started, end it. Type ENDTCPSVR

SERVER(*HTTP) on AS/400 command line and press Enter.

8. Start the OS/400 HTTP server. Type STRTCPSVR SERVER(*HTTP) on AS/400
command line.

5.9.2 Internet services setup
On Tivoli IT Director Management Console, click the Web Site Builder icon.

Figure 135. Web Site Builder icon
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In the Web Site Builder window, enter the information into the Web Site
Directory field. The HTML files of the Internet service will created into this
directory.

In the Page Option section, you can select functions that you want to publish
in the HTTP server. In this example, everything is selected as shown in Figure
136.

Figure 136. Web Site Builder window

The Browse button enables you to browse the AS/400 directory. See Figure
137 on page 145.
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Figure 137. Choose Directory window

After entering all information, click the Generate Web Site button. The HTML
files will be automatically created. After the process is finished, you will
receive a message as shown in Figure 138.

Figure 138. Process complete message

After completion of the Web Site Builder process, you can access it from a
Web browser. Type the following URL into your browser’s location field and
press Enter:

http://server_name/virtual_directory/default.htm

Default.htm is a welcome page for the Internet service. In this example, the
Web site is:

http://eagle/itdweb/default.htm

See Figure 139 on page 146.
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Figure 139. IT Director Homepage

For details about the Internet service configuration, refer to Chapter 18 of the
Tivoli IT Director User’s Guide.
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Chapter 6. AS/400 management scenarios

This chapter provides some AS/400 management scenarios using IT Director
for AS/400. Each example uses multiple management functions of IT Director
and provides seamless management scenario and the best practices.

6.1 Overview of our AS/400 management environment

To perform some AS/400 management scenarios, we configured a test
environment that consisted of AS/400 and Windows NT machines. Table 6
shows the AS/400s in our test environment:

Table 6. AS/400 test environment

Table 7 shows the Windows NT systems in our test environment.

Table 7. Windows NT test environment

In total, we had three AS/400s and three Windows NT machines, in which two
AS/400 were defined as managed systems. To manage this environment, we
used the three Windows NT machines as IT Director Management Consoles.

Machine Name Model OS/400 Version Server/Agent

EAGLE 170 V4R4 Server

FALCON 150 V4R4 Agent

RALYAS4B 170 V4R4 Agent

Machine Name Model Windows NT
Version

Agents

AUSRES36 Pentium II 450 MHz 4.0 Agent

AUSRES37 Pentium II 450 MHz 4.0 Agent

AUSRES38 Pentium II 350 MHz 4.0 Agent

AUSRES39 Pentium II 350 MHz 4.0 Agent
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Figure 140. ITSCO network test for IT Director

All functions of IT Director have been tested and run in this environment.

In all scenarios, the ITDADM user ID is used as an *SECOFR class ID on the
AS/400 machines and as Administrator on the Windows NT machines. The IT
Director Management Server is also configured to use this user ID. Please
refer to Chapter 4, “IT Director for AS/400: Installation and configuration” on
page 27 for instructions on how to configure the Tivoli IT Director
Management Server to use this user ID.

6.2 Automating the installation and configuration of new AS/400s

In this scenario, we plan to register and customize a new AS/400 in our
environment. This case can happen very often, and you do not want to waste
time on customizing an AS/400 and making it ready to work. In this scenario,
we intend to use IT Director for the following tasks:

ITD
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Agent
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ITD
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ITD
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Agent
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9.3.187.203

Local Area Network

Raleigh
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• Installing IT Director Agent

• Setting up security values in accordance with IT Director needs

• System statistics, user statistics, verifying sub-systems activity, job
statistics

• Retrieving inventory from this new machine

• Monitoring resources

• Processing tasks

6.2.1 Installation planning details
First, you should configure and customize the AS/400 network settings in
order to enable the TCP/IP network to reach the new AS/400. For more
information about TCP/IP configuration, refer to TCP/IP Configuration and
Reference V4R4, SC41-5420

Verify and check that the AS/400 has the required level of OS/400 and PTF
levels. For more detailed information, please refer to Chapter 3, “Tivoli IT
Director for AS/400: Planning” on page 11.

Save the product 1ITDAGT from your provider site in a save file, then send it
to the new, managed AS/400. After this operation, the new AS/400 can
receive the file.

To create a program that will perform the customizing operations for you, refer
to the next section. This program uses two parameters:

• Name of the save file

• Name of the user profile used as a default user profile

6.2.2 Details of the instructions used in the program
Execute the program with a user ID that has class equal to *SECOFR. If it is
not, the program will escape.

The product, 1ITDAGT, is restored from the save file.

The user ID you provide is added as the default user to allow the remote IT
Director Management Server to run AS/400 commands without specifying a
user ID and password.

Refer to Appendix A, “AS/400 Agent installation sample program” on page
219 for a listing of the CL Program.
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Create a save file to save the 1ITDAG licensed product (see Figure 141 on
page 150), then save the product by using OS/400 Save Licensed Program
(SAVLICPGM) command. Please refer to Figure 142 on page 151 for information
on the SAVLICPGM command.

Figure 141. Create Save File dialog

No other parameters are required to create a save file.

Before saving the product, you must stop both the IT Director Management
Server and Agent program. If you do not stop the programs, some objects will
be left used and locked and the save operation will fail.
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Figure 142. Save Licensed Program dialog

The name of the save file will be used by the installation program as a
parameter. Create another save file and send your installation program to the
target system.

Establish a session with the target system and restore the program.

If you are using FTP to send the save file, you have to create a save file on
the target system. Perform an FTP on the AS/400 functions in the same
manner as on other platforms.
Chapter 6. AS/400 management scenarios 151



Figure 143. Using FTP

Start an FTP session with the AS/400 and send the save file of the product
and the save file that contains the program, then restore the program:

RSTOBJ OBJ(MYPROGRAM) SAVLIB(MYLIB) DEV(*SAVF) SAVF(MYSAVF)

This program expects two parameters:

• Name of the user ID used by IT Director for remote commands

- For this scenario, we used ITDADM as the user ID

• Name of the save file

- The name of the save file is ITDAGSAVF

In the command line, type:

CALL MYLIB/MYPGM PARM(‘&PARM1 &PARM2’)

See Figure 144 on page 153.
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Figure 144. Call the installation program

The program was restored in QGPL library. User profile ITDADM has been
created and set to be the default user ID for IT Director Agent attributes.
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Figure 145. Attributes of IT Director Agent on target system

If the parameter Autostart has been set to *YES, the IT Director Management
Agent will start automatically when the AS/400 is IPL’d. The IT Director
Management Agent has to be started from the command line. To do this, type
the following command:

STRITDAGT

The AS/400 system will then be recognized by the server. In this scenario, all
commands used are simple. You do not need expertise to connect and
manage this new AS/400 in your network.
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Figure 146. Overview of the scenario

You can extend this scenario and add more instructions. For an example
program that manages your events, refer to Chapter 5, “Using Tivoli IT
Director for AS/400” on page 63 for more detailed information about event
management.

6.2.3 Managing your own environment
Now your AS/400 is connected to your network, and you are able to process
tasks on it.

In this scenario we want to check that a subsystem is active and monitor the
interactive sessions and batch jobs to see if they work. A process task has
been created, and this task gathered the following information about available
resources (to find out more about Resource Management, refer to 5.2,
“Resource monitoring” on page 76).

• Number of active jobs in the subsystem Qinter for interactive jobs

• Number of users signed on

• Subsystem status
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Figure 147. Process task: SubSystem Activity window

With this task, you can easily manage the Subsystems resources of this new
AS/400.

6.2.4 Create a Control Language Program
In this scenario, you need to know how to create and update a CL program.

If you want to create a library to work in, use the CRTLIB command to create a
library as follows:

CRTLIB LIB(MYLIB) TEXT(' Description text ')

Next, you have to create a source file. Use the CRTSRPF command to create a
source file, CRTSRCPF FILE(MYLIB/QCLSRC), the name of the file can be
whatever you want. In this example, it is named QCLSRC.

To work with this file, use the WRKMBRPDM MYLIBL/QCLSRC command to create a
member in the specified source file or to perform an operation with a member
that already exists in the source. Press the F6 key to create a new member.
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Figure 148. Work with Members Using PDM

When finished, press F3 (Exit). On the Exit panel, be sure to select Y at the
Change/Create member option.
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Figure 149. SEU Exit panel

Option 14 will compile the source member and create the program by the
same name and in the same library. Use the WRKOBJ command (for example,
WRKOBJ MYLIB/MYPGM) to verify that your program exists.

For more information about Control Language Programs, refer to the following
manuals:

• CL Programming V4R4, SC41-5721

• AS/400 CL Reference V4R4, SC41-5722

6.3 Redirection from AS/400 ITD Server to NT redirector

As mentioned earlier in the 5.4, “Software distribution” on page 101,
redirector servers act as local storage of IT Director software distribution
packages.

The following is an overview of the environment that we will use in this
scenario:
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Figure 150. Scenario environment overview

The IT Director Management Server, called EAGLE, is on a separate subnet
(Subnet A). The redirector server, AUSRES39, and some Windows NT based
Agent machines are on Subnet B.

When a software distribution command is sent to an Agent machine, that
machine checks its settings. If those settings indicate that it should use
AUSRES39 if possible, it will attempt to contact that machine and request the
software from there. If the connection is established, AUSRES39 will check to
see if it has the request in its local storage. If the package is not currently
stored on AUSRES39, it requests the package from EAGLE, stores it, and
then sends it on to the Agent machines.

In this way, the package is sent across the Wide Area Network (WAN) only
once, as opposed to sending it once to every Agent in the remote subnet.
Thus, a considerable chunk of bandwidth is saved, and the software
distribution process is accelerated.

Figure 151 on page 160 is an overview of the process.
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Figure 151. Overview of software redirection

As you can see, the software distribution command is sent to the Agents,
which send on a Software request to AUSRES39. And, if the software is not
available, it is requested from EAGLE by AUSRES39. After this, software
distribution proceeds to Agent machines. Since the software distribution is
only a small command and contains no files, it is quickly transferred over even
the slowest WANs. If AUSRES39 does not contain the requested package,
there is a significant transfer of data across the WAN.

6.3.1 Prerequisites
To replicate this scenario in your environment, you need the following:

• An AS/400 system with IT Director Management Server installed
(EAGLE).

• Latest cumulative PTF and PTF SF60739 and SF61121 for IT Director
Management Server installed (EAGLE).

• A Windows NT system with IT Director Agent installed (AUSRES39).

• IT Director Agent machine(s) that support software distribution.

• Administrator level access to both of the above systems.

• Basic knowledge of Windows NT User Management.
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The following items are not mandatory, but recommended:

• An extra Windows NT system (for extracting TWGSHARE.EXE)

• A group containing the machines that you wish to have use Redirection
(otherwise, you have to set redirection preferences one machine at a
time).

6.3.2 Creating an ITDADM user profile on AS/400
To create a user profile, use the CRTUSRPRF command on the AS/400 command
line. Type the CRTUSRPRF command on the AS/400 command line, then press
F4. The command prompt screen is displayed. Enter in the user profile
(ITDADM) and a password. This password should be same as the one in the
Windows NT domain. Enter *SECOFR for User class parameter. Then, type
Enter. A new user profile is now created.

In this example, ITDADM is created as *SECOFR. The kind of security
given to this new user profile depends on what kinds of tasks the default
user profile does. For detailed information about default user profile, refer
to the Tivoli IT Director User’s Guide. But, whatever level of security you
provide for this user profile in the AS/400, keep the password secret
because the same user profile is used in IT Director and Windows NT.

Note
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Figure 152. CRTUSRPRF command prompt screen

6.3.3 Assigning ITDADM as the IT Director default user profile
To assign default user profile, use the CHGITDSVRA command. For more
detailed information about this operation, please refer to Chapter 4, “IT
Director for AS/400: Installation and configuration” on page 27. Type the
CHGITDSVRA command on AS/400 command line and hit F4. In the command
prompt screen, enter ITDADM as Default User Profile parameter, then press
Enter.
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Figure 153. The CHGITDSVRA command

6.3.4 Creating an ITDADM user profile on Windows NT
Now that the IT Director Management Server on the AS/400 uses the
ITDADM user ID, you can create the same user ID on the Windows NT
machine(s) that you wish to use as redirectors. You can do this by creating
either a domain user ID (default for this scenario) or a local user ID. To do
this, you must:

1. Go to the User Manager for Domains on the machine you wish to use as
redirector.

2. Create a new user with the following settings:
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Figure 154. User ID settings

In the Username field, input ITDADM (caps optional). You may also want to
enter a description in the appropriate field to prevent accidental deletion of
the user ID. Enter the password for this user ID. This password must be the
same password that is used on the AS/400. If the password is ever changed
on the AS/400, it must be changed here as well. Then, remove the check
mark from the User Must Change Password at Next Logon box. Go to the
Groups window and make sure that this user ID belongs to the domain
Administrators group.

6.3.5 Getting TWGSHARE.EXE
In order to allow access to a share with no user ID and password (as often is
the case with IT Director), the TWGSHARE file is needed. Unfortunately this
file only comes with the Windows NT version of the IT Director Management
Server. To get this file, you must perform the following steps:

1. Install the IT Director Management Server on any machine (use default
settings for a quick installation and refer to the Tivoli IT Director User’s
Guide for instructions, if necessary).
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2. Once the server is installed, get the file called TWGSHARE.EXE from the
C:\Tivoliwg\Bin directory and copy it to a diskette or network drive.

3. Uninstall the IT Director Management Server from the machine (remember
to reinstall the Agent software).

6.3.6 Creating a share and using TWGSHARE on Windows NT
The next step is to create a share that is used to store the software
distribution packages and then use the TWGSHARE.EXE file to open this
share for all access. This is done by using the following steps:

1. Copy the TWGSHARE.EXE file into the C:\Tivoliwg\Bin directory (if you
installed the IT Director Agent software in another directory, please adjust
the path accordingly) on the selected redirector machine. In this case, we
use AUSRES39 as the example Windows NT server.

2. Create a new directory on the server called Redirect.

3. Assign Read access permissions to the Everyone group and Full Control
to the ITDADM user ID. Apply these permissions for both the Share and
File system. For an example, see Figure 155.

Figure 155. Setting Share Permissions
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Administrators and System accounts should also be allowed access to the file
system in this directory, but those settings should be decided by the local
server administrator.

4. After creating the share, you have to add the share to a list of shares that
do not need a user ID to log on. To do this, go to a Command Prompt and
type in the command: twgshare -a redirect and press Enter.

Figure 156. Using TWGSHARE.EXE

After adding the share to the NullSessionShares list, you can verify it by using
the twgshare -l command, and pressing Enter.

5. Reboot the machine, and you are done.

6.3.7 Settings in IT Director
To allow the Agent machines to use AUSRES39 as the redirector server, it
must be configured in the IT Director Management Console. You can do this
with the following two steps:

Since most redirector servers are remote machines, you might want to
consider using Remote Control and file transfer to facilitate this scenario.

Hint
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1. To configure AUSRES39 as a redirector, select Options -> Server
Preferences. Then, select the File Distribution Servers tab. To add a
new server, click Add to open the screen shown in Figure 157.

Figure 157. Adding redistribution servers

Here, you configure the UNC path of the redirection share, in this case,
specify \\ausres39\redirect, then click OK.

The redirection share should now be visible in the Share Names list (see
Figure 158 on page 168).
Chapter 6. AS/400 management scenarios 167



Figure 158. Server Preferences after adding the share

You can then close the Server Preferences screen by clicking OK.

2. Next, we will assign the Agent machines to use the newly configured
redirector server.

To configure the target machines, right-click on the Scenario machines
group and select Distribution Preferences.
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Figure 159. Starting Distribution Preferences

In the window shown in Figure 160 on page 170, click Add, enter the name of
the share, \\ausres39\redirect, and click the Restrict share selection to list.
This will force the machines to use AUSRES39 as their redirector server and
only go to EAGLE (the IT Director Management Server) in case AUSRES39 is
not available. Next, select File -> Save.
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Figure 160. Setting Distribution Preferences

In the bottom of the screen you can see the Status Messages field and the
responses from the Agent machines. This screen shows all the machines that
received the new settings.

The Agents are now using redirected software distribution. If you want to test
software distribution now, you can refer to 5.4, “Software distribution” on page
101 for instructions on how to create a software package and how to
distribute it.

6.3.8 Hints and tips
The following are hints and tips for this management scenario and should be
useful for your management environment.

• A good way to decide which redirector should be assigned to which
machine is based on Default Gateway attribute (found in the IP Address
folder).
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• If redirected distribution failed, check if the AS/400 is able to find the
Windows NT share directory. AS/400 uses a QNTC file system to access
Windows NT shared directories. This can be done with the following
procedure:

1. Sign on to the AS/400 using the ITDADM user profile (default user
profile).

2. Execute the AS/400 commands shown below on the AS/400
command line:

CD QNTC

CD AUSRES39 (Windows NT machine that is sharing the directory)

If you receive message “Object not found“, type the command:

CRTDIR AUSRES39

Then, type CD AUSRES39 again. Then execute

WRKLNK

3. You can see the shared directory names on Windows NT. If you can
not see any directories (except DSK), even if you have created a
shared resource on the Windows NT system, you need to check the
QNTC file system configuration. For detailed information about the
QNTC file system, refer to AS/400 - Implementing Windows NT on
the Integrated Netfinity Server, SG24-2164.
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Figure 161. The WRKLNK command

4. Type 5 (Next Level) on Opt column at shared directory, then press
Enter. You will see the contents of the shared directory as shown in
Figure 162 on page 173.

If you created the directory to see the shared directory by using the CRTDIR

command, it will disappear when the AS/400 is rebooted. You need to
re-create it.

Note
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Figure 162. Inside the shared directory

6.4 Redirection from AS/400 ITD Server to AS/400 redirector

Using an AS/400 as a redirector server is otherwise nearly identical to using
Windows NT as a redirector, but in this case, the TWGSHARE.EXE file
cannot be used to provide null credentials access. This slight difference
creates the need to send a user ID and password to the redirector in order to
access the share. On Windows NT, the user ID sent is the one used to start
the IT Director Agent (Director Support Program) service. This is the System
Account by default. In order to allow access, this must be changed to an
administrator level account. In this scenario, we will use the ITDADM account
created in the previous scenario for both the AS/400 and Windows NT
environment.

Other operating systems use the user ID and password that you are logged
on with to access the share. Therefore, you have the choice of allowing Read
access to everyone or using a Windows NT machine as the redirector in
cases where you have plenty of non-Windows NT Agent machines.
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6.4.1 Prerequisites
The following is a list of items needed to replicate this scenario:

• An AS/400 system with IT Director Management Server installed
(EAGLE).

• An AS/400 system with IT Director Management Agent installed
(FALCON).

• An Windows NT system with IT Director Management Agent installed
(AUSRES37).

• Administrator level access to the AS/400 and Windows NT machines.

6.4.2 Creating an ITDADM user profile in AS/400
For instructions on how to create ITDADM user ID in AS/400, please refer to
6.3.2, “Creating an ITDADM user profile on AS/400” on page 161.

6.4.3 Creating an ITDADM user profile in Windows NT
Please refer to 6.3.4, “Creating an ITDADM user profile on Windows NT” on
page 163 on instructions on how to create an ITDADM user ID in Windows
NT.

6.4.4 Changing an ITD service startup user ID in Windows NT
In this operation, you change the user ID used to start up the IT Director
Agent service on the Windows NT platform. To accomplish this, go to the IT
Director Management Console and open Process Management, then
right-click on Process Tasks and select Open.

In the Process Task window, you need to enter a command in the following
format:

twgipcsv -install Domain UserID Password

In this scenario, we used the ITSOAUSNT domain and ITDADM user ID. S, o
the command will be:

twgipcsv -install itsoausnt itdadm password

To allow the adding of ITDADM into the proper usergroups, a Domain
Administrator level user ID (in this scenario, ITDADM) must be given as a
Login User ID for the task along with its password. The following is an
example of the task that you need to create.
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Figure 163. Creating a task for ITD startup user ID change

After you enter the necessary data, select File -> Save and enter a
descriptive name for the task (we used Changing ID from ITD).

After you have created this task, just drag and drop it onto the machine(s) that
you wish to configure to use FALCON as their redirector server (in our case,
AUSRES37). Select Execute Now or Schedule the task for later execution.
However, this operation will shut down the IT Director Agent service, thus
making the machine unavailable until it has been rebooted. Therefore, it is
recommended that this task is run during the middle of the night so that the
machine is shut down when people leave work and restarts again the
following morning.

6.4.5 Creating and sharing the redirection directory on AS/400
To create a share on AS/400, you need to configure the AS/400 NetServer by
using the Operations Navigator. Detailed information about NetServer, refer
to The AS/400 NetServer Advantage, SG24-5196.

While it is possible to do this operation with a batch file that contains the
startup line for the IT Director Agent service, that batch file would also have
to contain the Administrator user ID and password. Sending this batch file
to users machines would be a serious security risk. On the other hand,
using the process task function does not leave files containing the
password on the hard drive, therefore, making it a secure function.

Note
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This section provides information on how to create a new directory on AS/400
and how to share it using the Operations Navigator. In this example, we
create an /itdadm directory (new directory) and share it.

1. Start Operations Navigator by using the ITDADM user profile and open the
folders in this order My AS/400 Connection -> Falcon (system name
where the share is created) -> File Systems -> Integrated File System ->
Root.

2. Right-click Root and select New Folder.

Figure 164. Creating a New Folder

3. In the New Folder window, type in a new folder name (we used redirect),
then click OK.

Figure 165. New Folder name
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4. Go back to the Operations Navigator window, right-click on the directory
you created in the previous process (redirect), and select Sharing -> New
Share.

Figure 166. Creating a New Share

5. In the AS/400 NetServer File Share window, type in the share name
(redirect) and Description (this is optional) information, then select
Read/Write in the Access field.
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Figure 167. AS/400 NetServer File Share window

6. If you want to change NetServer Name, you need to change it in the
NetServer property. Default Name of NetServer is Q+system name (in this
example, Qfalcon). To change it to Falcon, you need to stop NetServer.
Right-click on AS/400 NetServer and select Stop.

If you do not select Read/Write in the Access field (if it is left as Read only),
Tivoli IT Director Management Server can not write to this directory, and
the redirected software distribution will not work.

Note
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Figure 168. Stopping NetServer

7. Right-click on AS/400 NetServer again, then select Properties. In the
AS/400 NetServer Properties window, click the Next Start button.

Figure 169. AS/400 NetServer Properties

8. In the AS/400 NetServer General Next Start window, type the server
name. In this example, it is Falcon. Also, type the Domain name. This
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name should be the same as the Windows NT domain name. In this
example, it is ITSOAUSNT. Then, click OK.

Figure 170. NetServer General Next Start window

9. Next, start NetServer again. Right-click on AS/400 NetServer and select
Start.

Figure 171. Starting NetServer
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10.After you start NetServer, you can check if the Tivoli IT DIrector
Management Server machine can find this share or not. For more
information about this process, refer to 6.3.8, “Hints and tips” on page 170.
In this example, you should see redirect in directory /QNTC/falcon/.

6.4.6 Settings in IT Director
For more information about these settings, refer to 6.3.7, “Settings in IT
Director” on page 166 and follow the steps. The only difference is that instead
of \\AUSRES39\Redirect, you need to use \\FALCON\Redirect as the
redistribution path.

6.5 File transfer to and from AS/400: A workaround

Though file transfer to and from AS/400 systems (with the exception of the IT
Director Management Server) is not yet supported in this release, this
scenario presents a workaround for those who need AS/400 file transfer.

The basic idea in this scenario is to use the AS/400 NetServer facility to share
AS/400 resources and then map those resources into a drive on an Windows
NT machine. After this is done, you can use that Windows NT machine as a
gateway for file transfer. The path of the transferred file and the machines
involved are illustrated in Figure 172.

Figure 172. File transfer route to AS/400
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6.5.1 Prerequisites
For this scenario, the following items are needed:

• An AS/400 machine with IT Director Management Server installed
(EAGLE).

• An AS/400 machine with NetServer function and latest PTFs installed
(FALCON).

• An Windows NT machine (does not have to be Windows NT Server) with
IT Director Management Agent installed, preferably one dedicated for this
function (AUSRES37).

• Administrator level access to the AS/400s and the Windows NT machine.

6.5.2 Changing IT Director service user name in Windows NT
The first thing you have to do is to create a local user ID that has the same
name and password as the administrator in your IT Director Management
Server, in our case, ITDADM. Assign this user ID to the Administrators group.
Then, perform a logoff and a login with an ITDADM user ID.

Next, go to the Windows NT Control Panel and double-click Services. Select
Director Support Program and click Stop. You will be asked to confirm
stopping the service. Answer Yes. When the service is stopped, click
Startup.

Since this scenario will present a way to access AS/400 file systems with IT
Director user IDs, it is vital that you consider who will get access to the file
transfer task. If misused, this function may cause a serious security breach.
This scenario will also give hints on improving security.

Note
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Figure 173. Changing the ITD Agent service settings

A screen will open where you can set the user ID the service uses to start.
You set it by selecting the This Account button and typing in itdadm and
typing in the password. This is demonstrated in the Figure 174 on page 184.
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Figure 174. Setting the startup account for the service

Close this screen by clicking OK, and you will then return to the Services
screen. Making sure that Director Support Program is still selected, click
Start.

The service is now configured to send the ITDADM user ID and password if it
is asked for network access rights.

6.5.3 Creating the shares on AS/400
Now you need to configure which directories will be shared. In this example,
“/“ (Root) is shared with the ITDADM user profile and can access all AS/400
resources.

1. Start the Operations Navigator using the ITDADM user profile and follow
the tree My AS/400 Connection -> Falcon (name of the system that
shares its root directory) -> File Systems -> Integrated File System ->
Root.

2. Right-click on Root, then select Sharing -> New Share.
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Figure 175. Creating a New Share

3. In the AS/400 NetServer File Share window, enter the share name (we
used itdshare), description (this is optional), and select Read/Write in the
Access field. To set the Maximum number of users, select Maximum
users and type 1. This setting enables only one client to access this share
at the same time.
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Figure 176. NetServer File Share window

4. If you have not started NetServer yet, you need to start it. Right-click on
AS/400 NetServer in the Operations Navigator and select Start.
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Figure 177. Starting NetServer

6.5.4 Accessing shares from Windows NT
Now, you need to access the shares from the Windows NT system. To
accomplish this, start Windows NT Explorer and choose Tools -> Map
Network Drive.
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Figure 178. Mapping an AS/400 drive

Select a drive letter (we used L:, but this depends on your environment) and
set the path of the shared resource, \\falcon\itdshare, in this case.
Remember to check the Reconnect at Logon box; otherwise, you will lose
this mapping at next reboot. When done, click OK.

When using the file transfer task to AUSRES37, the AS/400 share will show
up as L: drive.

As we said earlier, there might be a security issue here. Allowing IT Director
access to people who are not supposed to get into AS/400 resources lets
them access AS/400 drives by using the file transfer task to the Windows NT
machine as a gateway.

You can prevent this by using one of two simple procedures:

1. By using IT Director Console Security, remove file transfer task privilege
from the users who should not have access to AS/400 resources.

2. Allow access to only groups that do not contain the machine that uses the
AS/400 share files (in our case, AUSRES37).
188 Managing AS/400 with Tivoli IT Director



The first one is the more secure manner because it disables the file transfer
task completely for all persons that you define. The second choice’s security
depends on how you define your groups; so, there is margin for human error.
This is why we recommend disabling file transfer over group access
restrictions.

For more information about Console Security, please refer to Tivoli IT Director
User’s Guide.

6.6 Managing large-scale AS/400 environments

This scenario provides an example on operating in a large AS/400
environment. Usually, many AS/400s exist in a single corporation, but they
are dispersed by purpose and department, and often, by location. They also
consist of several different hardware models and contain many different
software versions.

If you manage individual AS/400s using the Tivoli IT Director Management
Server, it is not nearly as effective as dividing them into several groups. Since
managing a group of machines takes almost the same amount of time and
effort as managing a single machine, using groups can easily multiply your
efficiency.

A sample environment is shown in Figure 179 on page 190.
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Figure 179. Sample environment for the scenario

This sample environment has three AS/400s. It is divided into two locations,
Austin and Raleigh. And, it has two types of applications, accounting and
personnel.

Scenario overview
The following are our scenario overview in this section:

1. The machines in the sample environment are grouped by three different
factors; these are as follows:

- Application

- Model

- Location

2. We will be using the following features for each group:

- Availability management

- Other management examples

In this scenario, each task is not explained in detail. For detailed information
about Tivoli IT Director Management Server’s tasks, refer to Chapter 5,
“Using Tivoli IT Director for AS/400” on page 63. After you create the groups,
these AS/400s are categorized as shown in Figure 180 on page 191.
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Figure 180. Categorized AS/400 environment

6.6.1 Creating groups
At first, you need to create groups. For detailed information about a group,
refer to Chapter 4 of the Tivoli IT Director User’s Guide. In this section, one
static group and two dynamic groups are created.

• Static group

- Application

• Dynamic groups

- Model

- Location

Even though Application belongs to a static group, you can group machines
dynamically according to the software they have installed. Application was
created as a static group to demonstrate static group creation.

This section provides information on creating each group.

6.6.1.1 Static group
To create a static group, you need to add each device manually. And, you can
create it by copying an existing default (or dynamic) group.

After the grouping
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In this example, the static group is created manually.

1. Right-click on the Groups pane. Select New Static....

Figure 181. Creating a new static group

2. A new pane is displayed. Drag and drop AS/400 devices from the Group
Contents pane onto the Static Group Editor pane. In this example, Eagle
and Ralyas4b are selected. Then, press Save.
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Figure 182. Select device for new group

3. The Save As window is then displayed. Type the name for the new group
(we used Account), then press OK.

Figure 183. Save As window

4. Confirm that the new group was created and that it contains the devices
you selected. You can check this by selecting the group in the Groups
pane and watching if the selected devices show up in the Group Contents
pane. Then, press Done.
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Figure 184. Static group creation complete

5. Create another static group using the same method. In this example, add
the device Falcon and save the group as Personnel.
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Figure 185. Create another static group

6.6.1.2 Dynamic group
If you create a dynamic group, devices are added automatically to the group if
their inventory information matches the parameters you selected. In this
example, two dynamic groups are created, Model and Location.

Model
1. Right-click on the Groups pane. Select New Dynamic....
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Figure 186. Create a new dynamic group

2. The Dynamic Group Editor window is displayed. In the Available Criteria
pane, select Inventory (AS/400) -> AS/400 Hardware -> Model, then
select 150 and then press Add.
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Figure 187. Select model for a new dynamic group

3. Select File -> Save or push the button as shown below

The Save As window is then displayed. Type in the group name. In this
sample, the group name is Model 150. Then, press OK.

Figure 188. Save As window

4. You can confirm that the new group is created, and the AS/400 model 150
machine is added to the group automatically. In this example, only Falcon
is added to the dynamic group automatically.
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Figure 189. Dynamic group creation complete

5. Create another dynamic group using the same method. But, in this
example, the group name is Model 170. Select Inventory(AS/400) ->
AS/400 Hardware -> Model -> 170 as criteria in the Dynamic Group
Editor window. Eagle and Ralyas4b are then added to this group
automatically.
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Figure 190. Another Dynamic Group created

Location
Basically, the way to create these groups is the same as in the Model group.
The difference is the criteria used in the Dynamic Group Editor window. In this
example, two dynamic groups are created, one for each location, Austin and
Raleigh.

To create the group, go to the Dynamic Group Editor window, select
Inventory (AS/400) -> IP Address -> Default Gateway (Router) ->
9.3.187.129 (this is the default gateway the AS/400s in Austin use) to create a
group for AS/400s in Austin, then select File -> Save to save the group. For
the Raleigh group AS/400, select Inventory(AS/400) -> IP Address ->
Default Gateway (Router) -> 9.24.104.1, then select File -> Save.
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Figure 191. Another Dynamic Group for location

Now Eagle and Falcon are added to the Austin group AS/400, and Ralyas4b
is added to the Raleigh group AS/400.
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Figure 192. Dynamic group for location complete

Therefore, at present, three groups are created. In the next section, we show
how to target IT Director Management Server tasks at these groups.

6.6.2 Setting tasks for each group
This section provides an example of setting tasks for each group. An outline
is:

• Availability management for application group

• Other management examples

You can set a task for a group (either a default group or the group(s) created
by you). It makes the whole process easy for you to manage the same kind of
AS/400s. The example settings are shown in following sections.

6.6.2.1 Availability management
This section uses AS/400 subsystems for availability management.
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In this example, two applications exists, Account and Personnel. Each
application uses its own subsystem, ACCO and PRES, respectively. These
subsystems should be working if you need to use applications (see Figure
193).

Figure 193. Sample application environment

Scenario overview
Resource monitoring task and process management task are used for this
scenario.

• Check the each subsystem status using the resource monitor.

• Create the process management tasks for each group.

• If subsystem is down, start it by using the process management task.

Resource monitor setting
The following are the procedures of the resource monitor settings:

1. First, to create resource monitor settings for the group Account, right-click
on group Account and select Resource Monitors.

AS/400 Subsystems manage resources on your AS/400. They control the
work flow and resources for all interactive and batch jobs on the machine. If
a particular subsystem is not running, then no jobs allocated to that
subsystem can be executed. If a subsystem suddenly ends, then all the
jobs running in it end also. Therefore, subsystems are a vital component of
AS/400 system availability.

Note

Account

EagleRalyas4b

SUBSYSTEM
ITDTEST/ACCO

Personnel

Falcon

SUBSYSTEM
ITDTEST/PERS
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Figure 194. Create Resource Monitor

2. In the Resource Monitors window, select the Subsystem status of
managed subsystem in the Available Resource pane. To do this, select
Director Agent -> AS/400 resource monitors -> Subsystems ->
ITDTEST/ACCO. This operation displays the subsystem status of Eagle
and Ralyas4b.
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Figure 195. Select Subsystem

3. Right-click on the Subsystem status row, and choose Group Threshold.

Figure 196. Create Group Threshold

4. When the Group Threshold window is displayed, type in a name for the
Threshold and set Minimum Duration to 5 minutes, 5 minutes Resend
Delay, and type 0 into the Low Error field. Then, type OK.
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Figure 197. Group Threshold window

5. In the Resource Monitors window, select File -> Save As from the tool bar
and type in a name for the Resource Monitor settings, then press OK.

You can change the Resend Delay value for your environment. In this
example, the event is periodically generated every five minutes as long as
the subsystem is down.

Note
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Figure 198. Save new resource monitor setting

6. Create another resource monitor setting for subsystem PERS for
Personnel group. Refer to the settings used for the Accounting group
earlier. Select ITDTEST/PERS instead of ITDTEST/ACCO as the
monitored subsystem.

Figure 199. Resource monitor setting for PERS subsystem

7. The resource monitor settings for each group are displayed in the console.
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Figure 200. All resource monitor settings

Process tasks setting
Create two process tasks to start each subsystem when they are down. For
detailed instructions on using process tasks, refer to Chapter 5, “Using Tivoli
IT Director for AS/400” on page 63.

1. Right-click on Process tasks and select Open.

Figure 201. Create new process tasks

2. Type the in the command, SYSTEM "STRSBS ITDTEST/ACCO". This is for the
group Account. Check the Log option and type in a user ID and password
(we used ITDADM as the user ID).
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Figure 202. Process Task window

3. Select File -> Save As from the tool bar. And, when the Save As window
is displayed, type in the process tasks name, then press OK.

Figure 203. Save As window

4. Create another task for group Personnel by following the instructions for
Accounting task. In this case, the command is SYSTEM "STRSBS

ITDTEST/PERS".

In this example, common user IDs and user profile are used for executing
tasks. If some AS/400s in your environment (group) do not have this user
ID and password, they will not work. In this case, you need to create
another task for each user ID and password.

Note
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Figure 204. Process Task for Personnel

Create an event action plan
Lastly, create an event action plan and tie the tasks that you created together.
For detailed information about settings of event action plan, refer to Chapter
5, “Using Tivoli IT Director for AS/400” on page 63.

1. On Event Action Plan Builder window, right-click on Event Action Plan
and select New.

Figure 205. Event Action Plan Builder window
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2. Type in the action plan name (we used Manage subsystem), then press
Enter.

Figure 206. Setting the event action plan name

3. Create an new event filter for subsystem ACCO. Re-check the Any box in
the Event Type tab and select Director -> AS/400 system monitors ->
ITDTEST/ACCO -> Subsystem status -> Low Error.

Figure 207. Create a new event filter

4. Select File -> Save as and enter a name for the filter (we used sbs ACC0
filter).
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Figure 208. Save Event Filter

5. Create another event filter for subsystem PERS in the same way. For this
filter, select Director -> AS/400 system monitors -> ITDTEST/PERS ->
Subsystem status -> Low Error in the Simple Event Filter Builder
window.

Figure 209. Event filter for subsystem PERS

6. To create an action, right-click on Start a Task on a “event“ system in
Action pane, then select Customize.
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Figure 210. Create a new action

7. In the Customize Action window, select the task that you created for
subsystem ACCO and save the action. Also, create another action for
subsystem PERS. When both actions are created, select Start a Task on
a “event“ system -> Action History -> Enable to enable the logging for
this task.

Figure 211. Select a task

8. Drag and drop the event filter onto the event action plan and then drop the
action onto the filter. In this example, for subsystem ACCO, drag and drop
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sbs ACCO filter (event filter) onto Manage subsystem (event action
plan) first, then drag and drop strsbs ACCO (action) onto the sbs ACCO
filter that you added in the previous process. For subsystem PERS, follow
the same instructions, just substitute the ACCO task and filter for the
PERS task and filter.

Figure 212. Event Action Plan completion

9. To add the event action plan to each group, open the Event Action Plans
window (right-click on Event Action Plans and select Open). Drag and
drop the event action plan that you created to each group. This event
action plan is now activated.
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Figure 213. Event Action Plans window

Testing the Event action plans
To test the event action plan, shutdown the subsystem PERS on Falcon using
the ENDSBS PERS command on AS/400 command line. Confirm that the PERS
subsystem is not active by issuing the WRKACTJOB command.
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Figure 214. The WRKACTJOB command

After five minutes, the PERS subsystem should start automatically.

Figure 215. Check PERS subsystem status
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You can check the action history on the strsbs PERS to verify that the task
has executed properly. To do this, go to Event Action Plan Builder, and in the
Action pane, select Start a Task on a “event“ system, then right-click on
strsbs PERS and select Action History -> Show.

Figure 216. Action History window

6.6.2.2 Other management examples
This section provides examples for other management methods using groups.

Resource monitor for model group
First, create a resource monitoring task for each model group (model 150 and
170 machines). Then, set the CPU Utilization % (found under System
Statistics) threshold for High error to 80 (percent) for the model 150 group
and 90 (percent) for the model 170 group. You can set different thresholds for
each group. This is convenient if you want to use the same event action plan
for different models (see Figure 217 on page 217).
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Figure 217. Resource monitor for model group

Schedule task for location group
This example is effective if your environment has a special event (for
example, a blackout). You can manage each location from the Tivoli IT
Director Management Console.

For example if one location has a planned blackout, you can schedule to
shutdown and restart AS/400 on Tivoli IT Director Management Console by
using the CHGPWRSCDE command. If you use AS/400 native job scheduler, you
need to set schedule for each machine individually

Inventory for Version Release group
In this sample environment, only the OS/400 V4R4 machine exists. Tivoli
Management Agent is also available for OS/400 V4R3. If you have an OS/400
V4R3 machine, you can create group for each OS/400 version release. Then,
you can check the inventory of software and cumulative PTF levels, and so
on, for each group.

Group Model 150

Falcon

Group Model 170

Eagle Ralyas4b

Event log

ITD consoleITD Server

CPU high utilization erorr
90 %

CPU high utilization erorr
80 %
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Appendix A. AS/400 Agent installation sample program

The following shows the sample program that installs the remote IT Director
agent.

PGM PARM(&ITDUSER &SAVFILE)
DCL &SAVFILE *CHAR 10 /* Name of Save File */
DCL &MSGUSRTXT *CHAR 132 /* Msg text to user */
DCL &USER *CHAR 10 /* User */
DCL &USRCLS *CHAR 10 /* User Class */
DCL &ITDUSER *CHAR 10 /* IT Director user for ITD Attributes */
DCL &ERRORSW TYPE(*LGL)
DCL &MSGID *CHAR 7 /*Specifies the message identifier*/
DCL &MSGDTA *CHAR 132 /* 1 st Level message text */
DCL &MSGF *CHAR 10 /* Name of the Msg File */
DCL &MSGFLIB *CHAR 10 /* Name of the Msg file Library */
DCL &MSGLEN *DEC LEN(5 0) /* total length of the message */
/* ================ Standard Error Handling ====================*/

MONMSG MSGID(CPF0000) EXEC(GOTO CMDLBL(ERROR))
/* ================ Retreive User Job Informations =============*/

RTVJOBA USER(&USER)
RTVUSRPRF USRCLS(&USRCLS)

/* ================ Check user class Informations =============*/
CHKAUT: IF COND(&USRCLS *NE '*SECOFR') THEN(SNDPGMMSG +

MSGID(CPF9898) MSGF(QCPFMSG) MSGDTA(' +
*SECOFR Authority is mandatory for this +
program') TOPGMQ(*PRV) MSGTYPE(*ESCAPE))

/* ================ Restore Licensed Product =============*/
RSTLIC:

RSTLICPGM LICPGM(1ITDAGT) DEV(*SAVF) SAVF(&SAVFILE)
CHGVAR VAR(&MSGUSRTXT) VALUE('RESTORE MSG ')
SNDPGMMSG MSGID(CPF9898) MSGF(QCPFMSG) +

MSGDTA(&MSGUSRTXT) TOPGMQ(*EXT) +
MSGTYPE(*STATUS)

/* ============ Create User profile for ITD Attributes==========*/
CRTUSERITD:

CRTUSRPRF USRPRF(&ITDUSER) PASSWORD(MYPWD) +
USRCLS(*SECOFR) INLMNU(*SIGNOFF) TEXT('IT +
DIRECTOR USER DO NOT DELETE')

/* ============ Change IT Director Attributes ==============*/
CHGITDATR:

CHGITDAGTA PROFILE(&ITDUSER)
/* ============ Change IT Director Agent Authoriztion list ====*/
CHGAUTL:

ADDAUTLE AUTL(TIVITAGT) USER(&ITDUSER) AUT(*CHANGE)
ERROR: +

IF COND(&ERRORSW) THEN(SNDPGMMSG MSGID(CPF9999) MSGF(QCPFMSG) +
MSGTYPE(*ESCAPE))

CHGVAR VAR(&ERRORSW) VALUE('1')
RCVMSG MSGTYPE(*EXCP) MSGDTA(&MSGDTA) MSGID(&MSGID) MSGF(&MSGF) +

MSGFLIB(&MSGFLIB)
IF COND(&MSGID *NE ' ') THEN(DO)
SNDPGMMSG MSGID(&MSGID) MSGF(&MSGFLIB/&MSGF) MSGDTA(&MSGDTA) +

TOPGMQ(*PRV) MSGTYPE(*ESCAPE)

ENDDO
ENDPGM
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Appendix B. Special notices

This publication is intended to help system designers and technical users of
Tivoli products to understand more about Tivoli IT Director for AS/400 and
how to manage AS/400 systems with Tivoli IT Director. The information in this
publication is not intended as the specification of any programming interfaces
that are provided by Tivoli. See the PUBLICATIONS section of the IBM
Programming Announcement for Tivoli for more information about what
publications are considered to be product documentation.

References in this publication to IBM products, programs or services do not
imply that IBM intends to make these available in all countries in which IBM
operates. Any reference to an IBM product, program, or service is not
intended to state or imply that only IBM's product, program, or service may be
used. Any functionally equivalent program that does not infringe any of IBM's
intellectual property rights may be used instead of the IBM product, program
or service.

Information in this book was developed in conjunction with use of the
equipment specified, and is limited in application to those specific hardware
and software products and levels.

IBM may have patents or pending patent applications covering subject matter
in this document. The furnishing of this document does not give you any
license to these patents. You can send license inquiries, in writing, to the IBM
Director of Licensing, IBM Corporation, North Castle Drive, Armonk, NY
10504-1785.

Licensees of this program who wish to have information about it for the
purpose of enabling: (i) the exchange of information between independently
created programs and other programs (including this one) and (ii) the mutual
use of the information which has been exchanged, should contact IBM
Corporation, Dept. 600A, Mail Drop 1329, Somers, NY 10589 USA.

Such information may be available, subject to appropriate terms and
conditions, including in some cases, payment of a fee.

The information contained in this document has not been submitted to any
formal IBM test and is distributed AS IS. The use of this information or the
implementation of any of these techniques is a customer responsibility and
depends on the customer's ability to evaluate and integrate them into the
customer's operational environment. While each item may have been
reviewed by IBM for accuracy in a specific situation, there is no guarantee
that the same or similar results will be obtained elsewhere. Customers
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attempting to adapt these techniques to their own environments do so at their
own risk.

Any pointers in this publication to external Web sites are provided for
convenience only and do not in any manner serve as an endorsement of
these Web sites.

The following terms are trademarks of the International Business Machines
Corporation in the United States and/or other countries:

The following terms are trademarks of other companies:

Tivoli, Manage. Anything. Anywhere.,The Power To Manage., Anything.
Anywhere.,TME, NetView, Cross-Site, Tivoli Ready, Tivoli Certified, Planet
Tivoli, and Tivoli Enterprise are trademarks or registered trademarks of Tivoli
Systems Inc., an IBM company, in the United States, other countries, or both.
In Denmark, Tivoli is a trademark licensed from Kjøbenhavns Sommer - Tivoli
A/S.

C-bus is a trademark of Corollary, Inc. in the United States and/or other
countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States and/or other
countries.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States and/or other countries.

PC Direct is a trademark of Ziff Communications Company in the United
States and/or other countries and is used by IBM Corporation under license.

ActionMedia, LANDesk, MMX, Pentium and ProShare are trademarks of Intel
Corporation in the United States and/or other countries.

UNIX is a registered trademark in the United States and other countries
licensed exclusively through The Open Group.

SET, SET Secure Electronic Transaction, and the SET Logo are trademarks

AIX AS/400
DB2 DB2 Universal Database
IBM Netfinity
OS/2 OS/400
SP Wizard
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owned by SET Secure Electronic Transaction LLC.

Lotus and 1-2-3 are registered trademarks of Lotus Development
Corporation.

Domino is a trademark of Lotus Development Corporation.

Other company, product, and service names may be trademarks or service
marks of others.
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Appendix C. Related publications

The publications listed in this section are considered particularly suitable for a
more detailed discussion of the topics covered in this redbook.

C.1 IBM Redbooks

For information on ordering these publications see “How to get IBM
Redbooks” on page 229.

• All About Tivoli Management Agents, SG24-5134

• AS/400 - Implementing Windows NT on the Integrated Netfinity Server,
SG24-2164

• Integration Examples for Tivoli IT Director: A First Look, SG24-5207

• Managing AS/400 with Tivoli Enterprise, SG24-5517

• Software Distribution with Tivoli IT Director, SG24-5493

• The AS/400 NetServer Advantage, SG24-5196

• Tivoli IT Director Automation, SG24-5295

C.2 IBM Redbooks collections

Redbooks are also available on the following CD-ROMs. Click the CD-ROMs
button at ibm.com/redbooks for information about all the CD-ROMs offered,
updates and formats.

CD-ROM Title Collection Kit
Number

System/390 Redbooks Collection SK2T-2177
Networking and Systems Management Redbooks Collection SK2T-6022
Transaction Processing and Data Management Redbooks Collection SK2T-8038
Lotus Redbooks Collection SK2T-8039
Tivoli Redbooks Collection SK2T-8044
AS/400 Redbooks Collection SK2T-2849

Netfinity Hardware and Software Redbooks Collection SK2T-8046
RS/6000 Redbooks Collection (BkMgr) SK2T-8040
RS/6000 Redbooks Collection (PDF Format) SK2T-8043
Application Development Redbooks Collection SK2T-8037
IBM Enterprise Storage and Systems Management Solutions SK3T-3694
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C.3 Other resources

These publications are also relevant as further information sources:

• AS/400 Alerts Support V4R1, SC41-5413

• AS/400 CL Reference V4R4, SC41-5722

• AS/400 Programming Reference Summary V4R4, SX41-5720

• AS/400 Security - Basic V4R5, SC41-5301

• AS/400 System Operation V3.6.0, SC41-4203

• Basic System Operation, Administration and Problem Handling,
SC41-5206

• CL Programming V4R4, SC41-5721

• Communications Configuration V4R1, SC41-5401

• HTTP Server Webmaster's Guide V4R4, GC41-5434

• OS/400 Backup and Recovery V4R4, SC41-5304

• OS/400 Security - Reference, SC41-5302

• OS/400 Work Management, SC41-5306

• Simple Network Management Protocol (SNMP) Support V4R1,
SC41-5412

• TCP/IP Configuration and Reference, SC41-5420

The following is product documentation:

• Tivoli IT Director User's Guide

C.4 Referenced Web sites

These Web sites are also relevant as further information sources:

• http://www.as400.ibm.com

• http://www.redbooks.ibm.com

• http://www.redbooks.ibm.com/abstracts/sg245196.html

• http://www.redbooks.ibm.com/abstracts/sg245207.html

• http://www.redbooks.ibm.com/abstracts/sg245295.html

• http://www.tivoli.com

• http://www.tivoli.com/products/index/it-director
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• http://www.tivoli.com/products/index/it-director_netview/index.html
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How to get IBM Redbooks

This section explains how both customers and IBM employees can find out about IBM Redbooks,
redpieces, and CD-ROMs. A form for ordering books and CD-ROMs by fax or e-mail is also provided.

• Redbooks Web Site ibm.com/redbooks

Search for, view, download, or order hardcopy/CD-ROM Redbooks from the Redbooks Web site.
Also read redpieces and download additional materials (code samples or diskette/CD-ROM images)
from this Redbooks site.

Redpieces are Redbooks in progress; not all Redbooks become redpieces and sometimes just a few
chapters will be published this way. The intent is to get the information out much quicker than the
formal publishing process allows.

• E-mail Orders

Send orders by e-mail including information from the IBM Redbooks fax order form to:

• Telephone Orders

• Fax Orders

This information was current at the time of publication, but is continually subject to change. The latest
information may be found at the Redbooks Web site.

In United States or Canada
Outside North America

e-mail address
pubscan@us.ibm.com
Contact information is in the “How to Order” section at this site:
http://www.elink.ibmlink.ibm.com/pbl/pbl

United States (toll free)
Canada (toll free)
Outside North America

1-800-879-2755
1-800-IBM-4YOU
Country coordinator phone number is in the “How to Order”
section at this site:
http://www.elink.ibmlink.ibm.com/pbl/pbl

United States (toll free)
Canada
Outside North America

1-800-445-9269
1-403-267-4455
Fax phone number is in the “How to Order” section at this site:
http://www.elink.ibmlink.ibm.com/pbl/pbl

IBM employees may register for information on workshops, residencies, and Redbooks by accessing
the IBM Intranet Web site at http://w3.itso.ibm.com/ and clicking the ITSO Mailing List button.
Look in the Materials repository for workshops, presentations, papers, and Web pages developed
and written by the ITSO technical professionals; click the Additional Materials button. Employees may
access MyNews at http://w3.ibm.com/ for redbook, residency, and workshop announcements.

IBM Intranet for Employees
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IBM Redbooks fax order form

Please send me the following:

We accept American Express, Diners, Eurocard, Master Card, and Visa. Payment by credit card not
available in all countries. Signature mandatory for credit card payment.

Title Order Number Quantity

First name Last name

Company

Address

City Postal code

Telephone number Telefax number VAT number

Invoice to customer number

Country

Credit card number
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Abbreviations and acronyms

AIX Advanced Interactive
Executive

AMP Application
Management Package

AMS Application
Management
Specification

BARC Before After Remove
Commit Script

CIM Common Information
Model

CLI Command Line
Interface

DB2 Database 2

DLL Dynamic Link Library

DMI Desktop Management
Interface

DNS Domain Name Service

FTP File Transfer Protocol

GUI Graphical User
Interface

IBM International Business
Machines

IFS Integrated File System

INS Integrated Nefinity
Server

IPCS Integrated Personal
Computer Server

IPX Internet Packet
Exchange

IT Information Technology

ITSO International Technical
Support Organization

LCF Lightweight Client
Framework

MDist Multiplexed Distribution
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MIB Management
Information Base

MIF Management
Information File

MSCS Microsoft Clustering
Service

RDBMS Relational Database
Management System

SNMP Simple Network
Management Protocol

TAP Tivoli Authentication
Package

TCP/IP Transmission Control
Protocol/Internet
Protocol

TEC Tivoli Enterprise
Console

TMA Tivoli Management
Agent

TME Tivoli Management
Environment

TMF Tivoli Management
Framework

TMR Tivoli Management
Region

TNR Tivoli Name Registry
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